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Foreword
Thank you for purchasing the Dagstation DX2000 (DX). This
manual describes the basic functions and operating procedures of
the DX2000. To ensure correct use, please read this manual
thoroughly before operation. The following four manuals are
provided as DX2000 manuals.
Paper Manual

Manual Title

Manual No.

DX2000 Operation Guide

IM 04L42B01-02E
This manual. It is also provided in the CD.

Electronic Manuals Provided on the Accompanying CD

Manual Title

Manual No.

DX2000 Operation Guide

IM 04L42B01-02E
This is the electronic version of the paper manual.

DX2000 User’s Manual

IM 04L42B01-01E
Describes how to use the convenient functions of the DX2000.
Communication function is excluded.

DX1000/DX1000N/DX2000

IM 04L41B01-17E

Communication Interface User’s Manual

Describes how to use the communication functions using the
Ethernet and serial interfaces.

DAQSTANDARD User’s Manual

IM 04L41B01-61E
Describes how to use the accompanying software program,
DAQSTANDARD.

Notes
« The contents of this manual are subject to change without prior

notice as a result of continuing improvements to the instrument’s
performance and functions.

Every effort has been made in the preparation of this manual to
ensure the accuracy of its contents. However, should you have
any questions or find any errors, please contact your nearest
YOKOGAWA dealer.

Copying or reproducing all or any part of the contents of this
manual without YOKOGAWA'’s permission is strictly prohibited.
The TCP/IP software of this product and the document
concerning the TCP/IP software have been developed/created
by YOKOGAWA based on the BSD Networking Software,
Release 1 that has been licensed from the Regents of the
University of California.

Trademarks

All the brands or names of Yokogawa Electric’s products used in
this manual are either trademarks or registered trademarks of
Yokogawa Electric Corporation.

Microsoft, MS-DOS, Windows, Windows NT, and Windows XP
are either registered trademarks or trademarks of Microsoft
Corporation in the United States and/or other countries.

Adobe, Acrobat, and PostScript are trademarks of Adobe
Systems Incorporated (Adobe Systems).

CompactFlash and CF are trademarks of SanDisk Corporation.
For purposes of this manual, the TM and ® symbols do not
accompany their respective trademark names or registered
trademark names.

Company and product names that appear in this manual are
trademarks or registered trademarks of their respective holders.

Revisions

1st Edition:

December 2005

1st Edition: December 2005 (YK)
All Right Reserved, Copyright © 2005, Yokogawa Electric Corporation

Safety Precautions
The DX conforms to IEC safety class | (provided with terminal for
protective grounding), Installation Category Il, and EN61326-1
(EMC standard), class A (use in a commercial, industrial, or
business environment).
The DX is a measurement category Il (CAT Il) instrument.

*

Measurement category Il (CAT Il)

Applies to measuring circuits connected to low voltage
installation, and electrical instruments supplied with power from
fixed equipment such as electric switchboards.

The general safety precautions described here must be observed
during all phases of operation. If the DX is used in a manner not
described in this manual, the protection provided by the DX may be
impaired. Yokogawa Electric Corporation assumes no liability for
the customer’s failure to comply with these requirements.
Use the DX as a measurement category Il (CAT Il) instrument.
The DX is designed for indoor use.

« About This Manual

Please pass this manual to the end user. We also ask you to
store this manual in a safe place.

Read this manual thoroughly and have a clear understanding of
the product before operation.

This manual explains the functions of the product. It does not
guarantee that the product will suit a particular purpose of the user.

Precautions Related to the Protection, Safety, and Alteration

of the Product
The following safety symbols are used on the product and in this
manual.

“Handle with care.” To avoid injury and damage to
the instrument, the operator must refer to the
explanation in the manual.

Protective ground terminal

Functional ground terminal (do not use this terminal
as a protective ground terminal.)

Alternating current

ON (power)

OFF (power)

Ol¢r®>

For the protection and safe use of the product and the system in
which this product is incorporated, be sure to follow the instructions
and precautions on safety that are stated in this manual whenever
you handle the product. Take special note that if you handle the
product in a manner that violates these instructions, the protection
functionality of the product may be damaged or impaired. In such
cases, YOKOGAWA does not guarantee the quality, performance,
function, and safety of product.

When installing protection and/or safety circuits such as lightning
protection devices and equipment for the product and control system
or designing or installing separate protection and/or safety circuits for
fool-proof design and fail-safe design of the processes and lines that
use the product and the control system, the user should implement
these using additional devices and equipment.

If you are replacing parts or consumable items of the product,
make sure to use parts specified by YOKOGAWA.

This product is not designed or manufactured to be used in
critical applications that directly affect or threaten human lives.
Such applications include nuclear power equipment, devices
using radioactivity, railway facilities, aviation equipment, air
navigation facilities, aviation facilities, and medical equipment. If
S0 used, it is the user’s responsibility to include in the system
additional equipment and devices that ensure personnel safety.
Do not modify this product.

IM 04L42B01-02E



Use the Correct Power Supply

Ensure that the source voltage matches the voltage of the power
supply before turning ON the power. In the case of a desktop
type, ensure that it is within the maximum rated voltage range of
the provided power cord before connecting the power cord.

Use the Correct Power Cord and Plug (Desktop Type)

To prevent electric shock or fire, be sure to use the power cord
supplied by YOKOGAWA. The main power plug must be
plugged into an outlet with a protective earth terminal. Do not
disable this protection by using an extension cord without
protective earth grounding.

Connect the Protective Grounding Terminal

Make sure to connect the protective grounding to prevent
electric shock before turning ON the power.

The power cord that comes with the desktop type is a three-
prong type power cord. Connect the power cord to a properly
grounded three-prong outlet.

Do Not Impair the Protective Grounding

Never cut off the internal or external protective grounding wire or
disconnect the wiring of the protective grounding terminal.
Doing so invalidates the protective functions of the instrument
and poses a potential shock hazard.

Do Not Operate with Defective Protective Grounding

Do not operate the instrument if the protective grounding might
be defective. Also, make sure to check them before operation.
Do Not Operate in an Explosive Atmosphere

Do not operate the instrument in the presence of flammable
liquids or vapors. Operation in such an environment constitutes
a safety hazard.

Prolonged use in a highly dense corrosive gas (H,S, SOx, etc.)
will cause a malfunction.

Do Not Remove Covers

The cover should be removed by YOKOGAWA'’s qualified
personnel only. Opening the cover is dangerous, because
some areas inside the instrument have high voltages.

Ground the Instrument before Making External Connections
Connect the protective grounding before connecting to the item
under measurement or control unit.

Damage to the Protection

Operating the instrument in a manner not described in this
manual may damage the instrument’s protection.

Exemption from Responsibility

YOKOGAWA makes no warranties regarding the product except
those stated in the WARRANTY that is provided separately.
YOKOGAWA assumes no liability to any party for any loss or
damage, direct or indirect, caused by the user or any
unpredictable defect of the product.

Handling Precautions of the Software

.

YOKOGAWA makes no warranties regarding the software
accompanying this product except those stated in the
WARRANTY that is provided separately.

Use the software on a single PC.

You must purchase another copy of the software, if you are to
use the software on another PC.

Copying the software for any purposes other than backup is

strictly prohibited.

Please store the original media containing the software in a safe
place.

Reverse engineering, such as decompiling of the software, is
strictly prohibited.

No portion of the software supplied by YOKOGAWA may be
transferred, exchanged, or sublet or leased for use by any third
party without prior permission by YOKOGAWA.

Handling Precautions of the DX

Use care when cleaning the DX, especially any plastic parts.
When cleaning, wipe using a dry soft cloth. Do not use
chemicals such as benzene or thinner, since these may cause
discoloring and deformation.

Keep electrically charged objects away from the signal
terminals. If you do, the DX may malfunction.

Do not apply volatile chemicals to the display, panel keys, etc.
Do not allow rubber and vinyl products to remain in contact with
the DX for long periods of time. If you do, the DX may
malfunction.

When not in use, make sure to turn OFF the power switch.

If there are any symptoms of trouble such as strange odors or
smoke coming from the DX, immediately turn OFF the power
switch and the power supply source. Then, contact your
nearest YOKOGAWA dealer.

Handling Precautions of the External Storage
Medium (CF Card)

Use caution in the handling of the external storage medium as it
is a delicate product.

Write operation to storage media may fail under high-
temperature or low-temperature environments. If you are using
the DX in a low-temperature environment (around 10 °C or
less), use the DX after the warm-up time (at least 30 minutes)
has elapsed. If you are using the DX under a high-temperature
environment (around 40 °C or more), it is recommended that the
external storage medium be inserted into the drive when saving
the data and be removed after the data storage operation is
finished.

Remove the storage medium from the drive when turning the
DX ON/OFF.

Touching the compact flash section when static electricity is built
up on the human body can lead to erroneous operation.

For the general handling precautions of the external storage
medium, see the instruction manual that came with the external
storage medium.

CAUTION

Do not eject the external storage medium while the access
indicator is illuminated. This can damage the data.

Do not access the storage medium in a place with vibrations or
shock. The storage medium or drive may malfunction.
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Checking the Contents of the Package Standard Accessories
Unpack the box and check the contents before operating the The standard accessories below are supplied with the instrument.
instrument. If some of the contents are not correct or missing or if Check that all contents are present and undamaged.
there is physical damage, contact the dealer from which you
purchased them.

DX2000

A name plate is located on the top panel of the DX (side panel on
models with the /H5[ ] option). Check that the model name and
suffix code given on the name plate on the rear panel match those
on your order.

YOKOGAWA 4 T

NO. (Instrument Number)
When contacting the dealer from which you purchased the
instrument, please give them the instrument number.

Y
8. One of these power cord types is supplied

according to the instrument’s suffix code
MODEL and SUFFIX Code

Model  [Suffix Code ggg:"a' Description

DXx2004 D DX2000 4ch, 125 ms (Fast sampling mode 25 ms) —

[DX2008 D DX2000 8ch, 125 ms (Fast ing mode 25 ms)

DX2010 D DX2000 10ch, 1 s (Fast ing mode 125 ms)

DX2020 D DX2000 20ch, 1 s (Fast ing mode 125 ms)

DX2030 D; DX2000 30ch, 1 s (Fast ing mode 125 ms) )

DX2040 D DX2000 40ch, 1 s (Fast ing mode 125 ms)

DX2048 D ion DX2000 48ch, 1 s (Fast ing mode 125 ms)

Internal -1 Standard memory

memory size |-2 Large memory No.Name Part Number/ Qty. Notes

External storage media| -4 With CF card Model

Language -1 Japanese (Japanese version of DAQSTANDARD included)

-2 English, deg F, and DST (English version of DAQSTANDARD included) 1 Terminal screws E9655FX 5 M4 (spares)
" T

Options ;2; ::::: Z::z:: i zz::::.,.ﬂ 2 Mounting brackets B9900BX 2 For panel mounting
/A3 Alarm output 6 points! Except for the /H5[ ]
/A4 Alarm output 12 points*18*11 models.
/A5 Alarm output 24 points™1°2'7*11
/C2 | RS-232 interface™ 3 Door lock key B8706FX 2 -
/c3 RS-422A/485 interface'3
D5 VGA output DAQSTANDARD DXA120 1 CD. Software for
/F1 FAlL/status output'2'4'8 for DXAdvanced setting the DX and
IF2 FAIL + alarm output 22 points*1*47*11 displaying data.
/H2 Clamped input terminal (d habl
/H5[] |Desktop type*s 5 DX2000 Operation M 04L42B01-02E 1 A4 size
A fea functions (noluding the teport function) Guide (this manual)
IN1 Cu10, Cu25 RTD input/3 leg isolated RTD
IN2 3 leg isolated RTD'6 6 User’s Manuals B8706ZZ 1 CD. Contains the PDF
IN3 Extended input type (PR40-20, Pt50, etc.) for the DX1000/ file of the user’s
/R1 Remote control11
/TPS4 | 24-VDC transmitter power supply (4 loops)™” DX1000N/DX2000 manual.
/TPS8 | 24-VDC transmitter power supply (8 loops)*7*8"11 7 CF card B9968NM 1 32 MB (The size and
/KB1__| Easy Text Entry (with input terminal)'9*10
/KB2 | Easy Text Entry (without input terminal)*® model may change.)
[USB1 {USB interface __ 8 Power cord A1006WD 1 Supplied only for
/PM1 | Pulse input (including remote control and

h I function)’1! models with the /H5D

/CC1__| Calibration correction function option. Maximum rated
/MC1_| External input function™12

— voltage: 125 V
*1 /A1,/A2,/A3, /A4, /A5, and /F2 cannot be specified simultaneously.

*2 /A5 and /F1 cannot be specified simultaneously. A1009WD 1 Supplied only for
*3 /C2 and /C3 cannot be specified simultaneously. .
*4 [F1 and /F2 cannot be specified simultaneously. models with the /H5F
5 /H5[] ) )
D: Power cord UL, CSA st'd option. Maximum rated
F: Power cord VDE st'd voltage: 250 V
R: Power cord SAA st'd
J: Power cord BS st'd A1024WD 1 Supplied only for
H: Power cord GB st'd .
6 /N2 can be specified only for DX2010, DX2020, DX2030, DX2040 and DX2048. models with the /H5R

*7 [TPS4,/TPS8, /A5 and /F2 cannot be specified simultaneously. . .
*8 If /TPS8 is specified, /A4 and /F1 cannot be specified simultaneously. option. Maximum rated
*9 /KB1 and /KB2 cannot be specified simultaneously. voltage: 250 V

*10 If /KB1 is specified, a remote control terminal (438227) is included.

*11 If /PM1 is specified, /A5, /F2, /M1, and /R1 cannot be specified simultaneously.
The combination of /A2/F1 and the combination of /A4/TPS8 cannot be
specified simultaneously.

*12 /MC1 can be specified only for DX2010, DX2020, DX2030, DX2040 and DX2048.
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No.Name Number/Model Qty. Notes
A1054WD 1 Supplied only for
models with the /H5J

option. Maximum rated
voltage: 250 V

A1064WD 1 Supplied only for
models with the /H5H
option. Maximum rated
voltage: 250 V

9 Remote control 438227 1 Remote controller.
terminal Supplied only for
models with the /KB1

option. With two AA
alkaline batteries and
labels for the remote
control terminal.

Optional Accessories (Sold Separately)

The following optional accessories are available for purchase
separately. If you make an order, make sure that all contents are
present and undamaged. For information about ordering
accessories, contact the dealer from which you purchased the DX.

No.Name Model Minimum Notes
Qty
1 CFcard 772091 1 128 MB
772092 1 256 MB
772093 1 512 MB
772094 1 1GB
CF card adapter 772090 1 -
Shunt resistor 415920 1 250 Q £ 0.1%

(for screw input terminal) 415921 1 100 Q = 0.1%

415922 1 10Q +0.1%

4 Shunt resistor 438920 1 250 Q £ 0.1%
(for clamped input terminal) 438901 4 100 Q + 0.1%
438922 1 10Q=+0.1%
Mounting brackets B9900BX 2 -
Door lock key B8706FX 1 -
Remote control terminal 438227 1 Remote
controller.

Conventions Used in This Manual

+ This manual covers information regarding DX2000s that have a
suffix code for language “-2” (English).
For details on how to set the language, see section 2.6, “Changing
the Language” in the DX2000 User’s Manual (IM 04L42B01-01E).

Unit
K: Denotes 1024. Example: 768 KB (file size)
k: Denotes 1000.

The following markings are used in this manual.

A

Improper handling or use can lead to injury to the user or damage to
the instrument. This symbol appears on the instrument to indicate
that the user must refer to the user’s manual for special instructions.
The same symbol appears in the corresponding place in the user’s
manual to identify those instructions. In the manual, the symbol is
used in conjunction with the word “WARNING” or “CAUTION.”

Calls attention to actions or conditions that could cause serious or
fatal injury to the user, and precautions that can be taken to
prevent such occurrences.

“CAUTION_

Calls attentions to actions or conditions that could cause light injury
to the user or damage to the instrument or user’s data, and
precautions that can be taken to prevent such occurrences.

Note
Calls attention to information that is important for proper operation
of the instrument.

>

Indicates after this mark reference to related procedure or explanation.
Bold characters

Indicates character strings that appear on the screen and the

operation keys.

Opening the Electronic Manuals

The accompanying CD contains PDF files of the manuals. When
you load the CD into the CD-ROM drive on your PC, a startup
screen appears. Click the manual title to open the respective
manual.

If the startup screen does not appear, double-click DX_manual in
My Computer, and open the manuals in the English directory.
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Introduction to Functions

Measured ltems

You can connect DC voltage, thermocouple, RTD, and ON/OFF input and measure various
values such as temperature and flow rate. The DX samples the input signals at the scan
interval to obtain the measured values. The fastest scan interval is 25 ms on the DX2004
and DX2008 and 125 ms on the DX2010, DX2020, DX2030, DX2040, and DX2048.

Up to four alarm conditions can be set for each measurement channel.

Data Storage Function

Display Function

Other Functions

DAQSTANDARD

There are two methods of recording measured data. One is to record the measured data
continuously, and the other is to record only when certain events occur such as alarms.
The measured data is recorded to the internal memory at a specified interval. The data
in the internal memory can be stored to a CF card automatically or manually. By
connecting to a network via the Ethernet interface, the measured data can also be
automatically transferred to an FTP server on a network.

Automatic data transfer to an FTP server

DX I — {|_FTP server
\ \

/\/ » Qernal memory)<> Q CF card
I ]

Measurement input W;@

Ethernet

Measured data can be displayed as trends, numeric values, and bar graphs for each
group. In addition, the overview display can be used to display and monitor all channels
on a single screen.

Trend display N
la g oo @ e

Computation Function (option) Various types of computation can be performed by
assigning equations to computation channels.

FAIlL/status output function (option) Outputs an alarm when the DX fails. The function also
monitors the DX status such as the remaining amount of
internal memory and outputs alarms.

Remote control function (option) A specified action is executed when a remote input
signal is applied to the terminal on the rear panel.

Security function Enables only registered users can operate the DX. The
function can also be used to prohibit key operation.

Communication function The Ethernet interface can be used to monitor the DX
using a Web browser and transmit e-mail when an event
occurs such as an alarm. In addition, data of devices on
the network can be loaded and displayed using the
Modbus protocol.

The accompanying software program, DAQSTANDARD, can be used to display the
measured data, convert the measured data format, and create DX setup data.

IM 04L42B01-02E



Introduction to Functions

DX System Configuration
The DX can be used to configure a system as shown below.
Referenced sections are of the DX2000 User’s Manual.
Referenced pages are of this manual.

==
— Pe
=3
Ethernet Lo -
(Communication Interface User's Manual) |
| PC

Temperature Recorder

controller

7 Serial communication*
in Measurement (Communication Interface
T{< T_ < input » User's Manual)
Sec. 3.3 .

Pulse input* » DX2000 » @ (;F ;:;c; o

P Sec. 3.10 ‘ ‘

p Page 57

; * USB flash memory
Transmitter power supply @ « USB port* b Sec.2.12

<~ Keys Keyboard

“ P Sec. 2.11

« Remote Terminal*
P Sec.2.10

« Remote input*

» Sec. 7.1

Monitor*
» p Page 58

Alarm output* «

P Sec 3.5-3.8

FAIL/status output* «

pSec. 2.9

*: Option
Terminology
+ Memory sample
The operation of recording measured data.
+ Memory start
The operation of starting the memory sample.
* Memory stop
The operation of stopping the memory sample.
- Display data
The waveform data shown on the DX display. The data recorded at the sampling
interval for the displayed data.
+ Event data
Measured data recorded at a sampling interval separate from that of the display data.
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Names of Parts

Front View
Key panel opened

LCD

Display various operation
displays such as the trend
display as well as setup
displays.

Front cover (Key panel)
Open the front cover by pulling
the cover while holding down
the tab at the center of the
upper section of the cover.

Power indicator

llluminates in red when the
power is turned ON. llluminates
in green while memory sample
is in progress.

Remote control sensor

(/KB1 and /KB2 options)
Receives infrared light from the
remote control terminal.

Key panel cover
Label (front of the key panel cover) Open the cover by pinching the
Write arbitrary labels for your left tab and pulling forward.
convenience.

Front cover opened

USB port CF card slot
A USB port conforming to Rev.
1.1.

— CF card access indicator

(FoWER)

Power switch ——— S
O © ©
o CF card eject button
Used when ejecting the CF
= - card.

Door lock key (included)
Insert the pin in the left hold to lock.
Insert the pin in the left hold to unlock.

10
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Names of Parts

Rear Panel

USB port (/lUSB1 option)

A USB port conforming to Rev.
1.1.

Ethernet port
A 10Base-T port.

VGA output connector SRAL
(/D5 option) ;

Serial interface port
(/C3 option)

A RS-422A/485 interface
connector.

Power supply terminal and
protective earth terminal.

Serial interface port
(/C2 option)

A RS-232 interface
connector.

A connector for an external
monitor.

Desktop Type (/H5[ ] Option)

Optional terminals (/A[ ], /F[ 1,
/R1,/TPS] ], and /PM1 options)
Connect optional input/output
signal wires.

Input terminals (screw terminals
or clamped terminals (/H2 option))
Connect input signal wires from the
measured item.

Functional
ground
terminal

— Power
connector

IM 04L42B01-02E
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DX2000 Workflow

When using the DX for the first time, carry out the following procedure.

Installation

Power ON

Environmental
Settings

i

Functional
Settings

AR
U

Measurement

i

Data
Management

Install the DX.
P Page 49 and subsequent pages

Connect input/output wires to the terminals and connectors on the
rear panel, and connect the power cord.
> Page 52 and subsequent pages

Turn the power ON.
P Page 13

Set the date/time, load the CF card, and so on.
P Page 18 and 24

Set measurement functions
P Page 19 and subsequent page, page 28 and subsequent pages

Start the measurement. Perform operations such as switching the
screen and writing messages. Save the measured data.
P Page 39 and subsequent pages

Check and manage the measured data.

Use the accompanying software program, DAQSTANDARD, to display
the measured data and convert the measured data to Excel, Lotus, and
ASCII formats.

P Page 48

P DAQSTANDARD User's manual (IM 04L41B01-61E)

12
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Turning the Power ON/OFF

Turning the Power ON

A

A

Turning the Power OFF

A

.

_‘l

.

CAUTION

Before turning ON the power switch, check that

The power cord/wires are connected correctly to the DX.

The DX is connected to the correct power supply (see page 60).

If the input wires are connected in parallel with other devices, do not turn ON/OFF
the power switch of the DX or another device during operation. This can have
adverse effects on the measured values.

Open the operation cover.
Turn ON the power switch.
After performing a self-test for a few seconds, the operation screen appears.

Close the operation cover.

CAUTION

If nothing is displayed when the power switch is turned ON, turn OFF the power
switch and check the points listed above one more time. After checking the
points, turn ON the power switch again. If the DX still does not work, it is
probably a malfunction. Contact your nearest YOKOGAWA dealer for repairs.
If an error message is displayed on the screen, take measures according to the
description in chapter 11, “Troubleshooting” in the DX2000 User’s Manual.
Turn ON the power switch, let the DX warm up for at least 30 minutes, and then
start the measurements.

CAUTION

Before turning OFF the power switch, check that the external storage medium is
not being accessed.

1.
2
3

Open the operation cover.
Turn OFF the power switch.
Close the operation cover.

IM 04L42B01-02E
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Basic Operation

Panel Keys and Display
Keys

o—| LCD

Key panel

DISP/ENTER key and four arrow
keys (up, down, left, and right)

Soft keys Switches the operation screen.
Selects the menu that is Selects and enters setup items.
displayed at the bottom of the —

screen —— DISP/ENTER key

Up arrow key

Right arrow key

Memory start/stop

Down arrow key

START/STOP key ({e START ) —({@Esc ||MENU@— E
@
G

USER FU“C
Left arrow key
ESC key . Character/Number input keys
Cancels an operation Enters characters and numbers
USER key .
) MENU key Favorite key
E h ; .
osgfa“ttgﬁt ¢ assigned Switches between the operation  Displays the operation screen (up to
mode and setting mode :arllgh; screens) that are registered to
e key

FUNC key

« Displays the soft key menu in operation mode

» Hold down this key at least 3 s in the setting mode to switch from the setting
mode to the basic setting mode

14 IM 04L42B01-02E



Basic Operation

Display

b/ glo53:67 ors NI 11nin @E o Status display section

1ninsdiv 500 | ° Shows the display name, date/time, data
recording, alarm icon, etc.

Data display section
Shows the measured data and the
functional setup display.

jp12a7 EicE o1

Display on the Status Display Section
The following information is displayed in the status display section.
Memory sample status

Data type
DISP: Display data

=3 EVENT: Event data
Memory sample @

stopped Memory sample progress
: & Displays the progress using a green bar graph. The frame indicates the file save :
Memory sample ' interval (display data) or the data length (event data).
3 In progress ] m Error in internal memory. 1
Memory sample icon Displays the remaining memory sample time for the left bar graph.

GROUP 1 il €3 :
o a/22 18:57:05 ) V15> NI ¢Gnin

Alarm icon
Displayed when any alarm is activated.

Blinks when there are alarms that are
occurring but have not been acknowledged.

Display name or group name
For all channel display on the trend display,
“ALL” is displayed.

Date and time
Displayed in yellow while the time is being corrected.

(Red)

i . All alarms have been released after they
When using the batch function have occurred, but there are alarms that

P1-process-ABAAA3 Batch name (shown aIternater‘ (Green) have not been acknowledged.
R IR with the display name)
Date and time Status icon

m The status assigned to the status output
relay (/F1 option) is occurring.

B Keys are locked.

If the “batch number-lot number” exceeds 20
characters, the “date and time” position is used to
display the “batch number-lot number.”

. E-mail transmission is enabled.
Name of the user logged in E

Display name
Date and time

Computation icon (/M1 option)

White icon: Computation in progress
When using the login and batch functions

Name of the user logged in
Batch name (shown alternately‘
with the display name) | CF card icon
Date and time | L@

[E‘! CF card is being accessed.
The green level display indicates the amount of ——g Waiting.
CF card used. If the remaining amount falls to @ CF card error.

10% or less of the CF card capacity, the color
changes to red.

When using the login function ;

Yellow icon: Computation dropout occurred

IM 04L42B01-02E



Basic Operation

Run Modes

Mode Transition Diagram

Power ON

;

Operation mode

Setting mode

MENU key

End menu > DISP/ENTER key

Setting menu

Hold the
FUNC key
for 3
seconds

Basic setting mode

Basic setting

display

MENU key
or ESC key

|
DISP/ENTER

MENU key
key

or ESC key

The DX has three modes.

menu display

 I—
DISP/ENTER

Key } ESC key

o imunal

| 3 o i
| S rna) N
| B st i

[“-‘-"h Setup display

l?l

Mode

Description

Operation mode

A mode for performing measurements.

Setting mode

A mode in which input range, measurement method, and so on are
configured. Settings can be changed when memory sample is in
progress excluding some items.

Basic setting mode

A mode used to set basic items such as the scan interval and storage

format of measured data. You cannot switch to this mode when memory

sample is in progress.

* For further details on the basic setting mode and setting mode, see page 63.

Carry out the steps given in the following pages. It will help you to understand the DX

operation.

16
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Basic Operation

Entering Values and Characters

The character/number input keys and DISP/ENTER key are used to set the date/time,
set the display span of the input range, set the tag, set the message string, enter the
password, etc.

DISP/ENTER key and four arrow
Character/Number input keys keys (up, down, left, and right)

=Y
II>
]
o

~
«
2
(o)
g
©
R

AN,

o
&

f\f\gf\
NE/ANS/ANS/ANS)

‘
+
*

nnri)r\

Entering Values
When a window for entering a value appears, enter the value by performing the following
key operation.
+ Left and right arrow keys: Selects the input position.
Character/Number input keys: Enters a value.
The following soft key appears when it can be used.

+ Space soft key: Enters a space.

Entering Character Strings

When a window for entering a character string appears, enter it by performing the
following key operation.

Left and right arrow keys: Selects the input position.
+ Character/Number input keys: Enters a character string.
The character to be entered is determined by the number of times the character type key
and the character/number input key is pressed. The character types that can be entered
vary depending on the item being set.

Space Del Bs Ins A/a‘l

Input status of the A/a/1 soft key

Input status of the Ins soft key

Space soft key: Enters a space.

Del soft key: Deletes the character at the cursor.
Bs soft key: Deletes the character before the cursor.
* Ins soft key: Selects insert or overwrite.

Insert and overwrite mode toggles each time the Ins soft key is
pressed. The selected mode is shown on the right side of the soft
key display section.

A/a/1 soft key: Selects uppercase alphabet (A), lowercase alphabet (a), or value
(1).
The character type that you can enter changes each time you press
the A/a/1 soft key. The selected character type is shown on the
right side of the soft key display section.

IM 04L42B01-02E
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Basic Operation

Changing the Date/Time
In this example, we will change the date to the 14th. After carrying out this step, reset
the time to the correct date/time.

1. Display the operation mode screen.

GROLP 1 = ,
2005/12/01 B2:02:29  \red 1% I 16nin

y

0.0000
— v
0.0000

v

0.8040

y

0.0008

y

0.0000
v
0.0008
[
0.60a0

2. Press MENU once to display the setting menu.

GROLP 1 = :
S mompos Rl D1 N enin (D)
Select DateTime

Meas channel
Hath channel

Ext. channel

v v v w

Display

Group set, Trip line
Message

Tiner, Event action
Data save

Save/Load

Yy v v v

Henu customize

3. Press DISP/ENTER once to open the Time set window.
4. Setthe date to 14.
Select the input position: Left and right arrow keys

Change the value: Character/Number input keys
Enter the input: DISP/ENTER
Cancel the setting: Press ESC before pressing DISP/ENTER.

S 11/a1 ap-ep-se G o N 0 (5)
Heas channel »
Hath channel

Ext. channel

\
\ g5/12/14 [2:82:4% - Display the Time set
Display % window

Group set, Trip line
Hessage

Timer, Event action
Data save

Save/Load

vy v v v

Menu customize

5. Press ESC or MENU once to return to the operation mode screen.

Operation complete.

18
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Basic Operation

Operation Example in the Setting Mode: Changing the Input Range
Set the input range of channel 2 to thermocouple type T and 0.0 to 400.0°C.

DX2000
\ \

TypeT
thermocouple Channel 2

S

HEO

1. Display the operation mode screen.

GROUP 1 = -
2005/12/81 a2:ng:00 e D157 NN 16nin

Press MENU once to display the setting menu.
Press the down arrow key once to select Meas. Channel.
Press the right arrow key once.

AWN

GROUP 1 F= :
2n05/12/81 a2:03:15 e ISP I 16nin

Date/Tine
Selectthe Range, Alarm
ftath channel Tag. Hemory sanple. Alarm delay
Ext. channel
Hoving average
Display

Color
Group set. Trip line
Zone, Scale, Bar graph
Message
. . Alarn mark, Color scale band
Timer. Event action

Calibration correction

Data save
Save/Load »
Henu customize 4

5. Press DISP/ENTER once.

GROLP 1 = :
1o peopon R Vs N in (S

First-CH Last-CH 861
= Range Select First-CH
Hode Range Span Lover  Span Upper
Volt 2V -2. 1660 2. 6088
r Alarn
1 |off
2 | Off
3 |Off
4 | Off

IM 04L42B01-02E
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Basic Operation

11.
12
13.

Press the Input soft key once.

GROUP 1 = :
a2 ne:na:ae e ISP NN 10nin 1]

Meas channel > Range. Alarn

First-CH Last-CH BA1
r Range

Hode Range Span Lower  Span Upper ‘

Yolt ) -2. 6668 2. BARA
[:BL
¢ — Display the channel
setting window

r Alarn

1 0f f

2 |0ff

3 | 0ff

4 | 0ff

Enter 002.

Select the digit: Left and right arrow keys

Change the value: Character/Number input keys

Delete the value: Space soft key

Cancel the setting: Press ESC before pressing DISP/ENTER.
Press DISP/ENTER once. The last channel is also set to 002.
Press the down arrow key once to move the cursor to Mode.

Press the TC soft key once. The cursor moves to Range, and the changed item

is displayed in yellow.

GROUP 1 F= :
Soaibm moaacia e D1 N min (S

Heas channel > Range. Alarn

First-CH [eB2 Last-CH [
r Range
HMode Range Span Lover  Span Unper
TC R | 0.0 1760.0
t SelectTC
r Alarn
1 |off
2 |off
3 |off
4 |off
R S B K E J Next 1/2

Press the Next soft key.
Press the T soft key once. The cursor moves to Span Lower.
Press the Input soft key once.

GROUP 1 =]
e ez e v N o (9 N
Heas channel > Range, Alarn

First-CH [eB2 Last-CH B

r Range

Hode Range Span Lower  Span Upper ‘

TC T -200.8 4R A
-268.8

setting window

Alarn

off

ol
2 E
g g

1
E B €3 M3

20
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Basic Operation

14. Enter 0.0 in the Span Lower box.
See step 7 for the procedure.

15. Press DISP/ENTER once. The cursor moves to Span Upper.

16. Enter 400.0 in the Span Upper box.
See step 7 for the procedure.

17. Press DISP/ENTER once. The changed items are entered, and the cursor
returns to First-CH. The changed items change from yellow to white.

GROUP 1 &= )
2a5/12/81 82:04:49 e 1P NN 16win ©
Meas channel > Range. Alarm

First-CH Last-CH 862

r Range
Hode Range Span Lower  Span Upper

[T T [ 8@ [ 4888

r Alarn

1 [off
2 [off
3 [off
4 [off

18. Press ESC or MENU three times to return to the operation mode screen.

Operation complete.

IM 04L42B01-02E
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Basic Operation

Operation Example in the Basic Setting Mode: Changing the Scan Interval
In this example, we will change the scan interval. Here, the scan interval on the DX2010
is changed to 2 s. The selectable scan intervals are different on the DX2004 and
DX2008, but the procedure is the same.

DX2000
Measures every 2 s I
TypeT
thermocouple ~ Channel 2
<

1. Display the operation mode screen.

GROLP 1 = :
2665/12/81 B:39:09 DIsP I 11nin

Inin/div

2. Press MENU once to display the setting menu.

GROLP 1 r= _
ogs/12/81 2-pe-as  hed DIsP NN 10min @

Heas channel

Math channel

Ext. channel

v v v w

Display

Group set, Trip line
Hessage

Tiner, Event action
Data save

Save/Load

v v v v

Menu customize

3. Hold down FUNC for at least 3 s.

Basic Setting Hode

Setting menu & | — Display the basic setting

mode menu

A/D, Memory

Burnout. RJC

Environment »

Report »

Time settings

Load settings. Initialize »

Comnunication (Ethernet} »

Comnunication ($erial} »

Status relay

End

4. Press the down arrow key once to select A/D, Memory.

22
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Basic Operation

5.

10.
11.

12

Press DISP/ENTER once.

A/D, Henory

Scan interval

Sean mode
Scan interval 1s
A/D integrate fAuto

Hemory
{Data kind

[ Diselay

Press the down arrow key once to move the cursor to Scan interval.
Press the 2s soft key once. The cursor moves to A/D integrate, and the
changed item is displayed in yellow.

Cancel the setting: Press ESC before pressing DISP/ENTER.

Press DISP/ENTER once. The changed items are entered, and the cursor
returns to Scan mode.

A/D, Hemory

Scan interval

Scan mode
Scan interval s e Set the scan intervalto 2 s
A/D integrate Auto

Hemory
{Data kind

Press ESC once to return to the basic setting mode menu.
Press the up arrow key twice to move the cursor to End.
Press DISP/ENTER once.

Basic Setting Hode

Setting menu

— Display the basic setting

Alarn mode menu

A/D, Hemory

Burnout. RJC

Environment

Report ® Display the confirmation
Tine settings Mo | [ Cancel window

Load settings. Initialize 4

Conmnunication {Ethernet} b

Comnunication {Serial) 4

Status relay

Press DISP/ENTER once. The settings are saved, and the DX returns to the
operation mode screen.

Discard the changes: Select No and press DISP/ENTER.

Do not end the basic setting mode: Select Cancel and press DISP/ENTER.

Operation complete.

IM 04L42B01-02E
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Basic Operation

Inserting/Removing a CF Card

Inserting a CF Card
1. Open the operation cover.

CAUTION

Forcing the CF card into the slot with
the upside down may cause damage.

With the label “This side up”
uacing up

2

Insert the CF card into the slot.

GROUP 1

—
a2 nedizln pee ISP NN 1houwr

Displays the storage
media icon

I v
0.08080
E____ T
.06080
Y
B.060008
.y
0.080860
B T
0.06000

y

0.08080

]

0.06080

Y

B.060008

y

0.00860

[
B.06008

3. Close the operation cover.
Operation complete.

Removing a CF Card
<Operations in the Operation Mode>
1. Press FUNC once.
2. Press the Next soft key.

GROUP 1

<~
onpsri2/e a2-ai-oa  ped D1SP NN lhour

@é Storage media icon

Free
nessage

Manual | s 1/
¥

AlarnACK | Hessage axt 1
| sample |

— Media eject

eject | shot

24
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Basic Operation

O AW

7.

Press the Media eject soft key once.

Press the CF soft key once. The message “Media can be removed safely”
appears.

Open the operation cover.

Press the CF card eject button. When you eject the CF card, the storage media
icon disappears.

Press the eject button in until it clicks.
The eject button stops at depressed
position. Pinch the left and right side
of the CF card and remove it.

7'4 Eject button

Close the operation cover.

Operation complete.

<Operation in the Basic Setting Mode>

1.

2
3.
4.

Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to
the basic setting mode), select Load settings, Initialize > Media eject > CF,
and press DISP/ENTER.

Basic Setting Hode

Setting menu

Alarn

A/D, Menory

Burnout, RJC

Envi ronnent »
Report »

Time settings
Load settings, Initialize Load settings
Connunication (Ethernet) Initialize
Connunication (Serial)
Select CF

Status relay
End

The message “Media can be removed safely” appears.
Open the operation cover.
Press the CF card eject button. Remove the CF card.
Close the operation cover.

Operation complete.

Note

If you remove the CF card without carrying out the media eject procedure, the message “Media
was removed compulsorily” appears. Remove the CF card by carrying out the procedure above
to prevent damaging the data that is stored.

IM 04L42B01-02E
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Basic Operation

Saving the Setup Data
In this example, we will save the setup data to a file named “SF2” on the CF card.

1. Display the operation mode screen.

GROUP 1 —
anmsnza peai:ia e ISP NN 1howr

B N
0.0008
(v
0.00008
5 TN
.0086
y

.006a

y

.0086

y

08.00068

y

08.0008

v
L 8.0000

Press MENU once to display the setting menu.
Press the up arrow key twice to select Save/Load.
Press the right arrow key once and down arrow key three times.

=

= (=

AWN

R b/a - vise I b (©)
Date/Time
Heas channel »
Hath channel »
Ext. channel »
Display .

Load display data
Group set, Trip line

Load event data
Hessage

Timer. Event action Load settings

Data save Select Save settings

Save/Load File list/delete
Henu custonize Fornat

5. Press DISP/ENTER once.
6. Enter “SF2” for the file name.
For the input procedure, see “Entering Values and Characters” on page 18.

GROUP 1 =1
SR vl peraz-gs ed DisP NN lhor D)
Save/Load > Save settings

Save settings
’7Fi le name CF:s [5F20

Space | Del Bs Ins | Asarl
7. Press DISP/ENTER once. The message “Data are being saved to media”
appears, and the setup data is saved.
8. Press ESC or MENU three times to return to the operation mode screen.

Operation complete.
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Basic Operation

Loading the Setup Data

In this example, we will load the setup data “SF2” from the CF card and update the DX settings.
Here, only the setup data of the setting mode is loaded. To load the setup data of both
the setting mode and basic setting mode, press MENU, hold down FUNC for 3 s, select
Load settings, Initialize > Load settings, and press DISP/ENTER.

W=

NSO

Display the operation mode screen.

Press MENU once to display the setting menu.

Press the up arrow key twice to select Save/Load.

Press the right arrow key once and down arrow key twice.

GROUP 1 &
S ez e 015 I 1ror (D)
Date/Time
Heas channel »
Hath channel »
Ext. channel »
Display L
Load display data

Grour set. Trip line
Load event data
Hessage

Tiner, Event action Select Load settings

Data save Save settings
Henu custonmize Fornat

Press DISP/ENTER once to select the root directory (CF:/).
Press DISP/ENTER once to display the files in the root directory.
Select the file SF2.PDL using the up and down arrow keys.

GROUP 1 o= ,
2385/12/81 82:12:27 DIsP RN 29nin 1] 0}

Save/Load > Load settings

7 To move to a lower
File nane Date / Tine directory, select the
SF2. POL 2885/12/81 B2:43 directory, and press
DISP/ENTER.

To move to a higher

Free space 31468 Kbytes

Press DISP/ENTER once. The message “File is being loaded from media”
appears, and the setup data is loaded. The DX automatically returns to the
operation mode screen.

Operation complete.

directory, press ESC.
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Setting the Input Range and Alarm

Setup Example 1: Temperature Measurement Channel

DX2000
I I
TypeT
thermocouple Channel 1
<
0.0 to 200.0°C
Setup Item Description Number in the Figure
Channel Use channel 1. 1
Tag TI-001 2
Sensor Type T thermocouple 3
Input range 0.0 to 200.0°C 4

(1) Input Range
Press MENU (switch to the setting mode).
From the setting menu, select Meas Channel > Range, Alarm.

GROUP 1 =
o bl gp-aqes e vl N tor (5]
Heas channel > Range. Alarm

First-CH %ﬂ Last-CH l@
Range

1
Hode Range Span Lover  $pan Lpper 1
C 8.8 27@.8
! s
3
r Alarm
1 [off
2 [off
3 [off
4 |[off
| Inout
(2) Tag

From the setting menu, select Meas Channel > Tag, Memory sample, Alarm delay.

GROUP 1 ]
R s T V1 N tor (S
Heas channel > Tag, Hemory sample, Alarn delay

First-CH [N Last-CH 8a1

Tag
{Ta TI-801 P 2

{ Hemory sanple
0

n/0ff On

Alarm delay
{Time 18 s

Operation complete.
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Setting the Input Range and Alarm

Setup Example 2: Flow Rate Measurement Channel and Alarm

DX2000
\ \

Flowmeter Channel 2

o e

Convert to 1-5V with a shunt resistor

Setup Item Description Number in the Figure
Channel Use channel 2. 1
Tag FI-002 2
Input signal 1-5V 3
Input range 0.0 to 500.0 L/H 4
Alarm condition Output an alarm if the measured 5

value is less than or equal to 120.0 L/H.
Output destination: Relay contact (103)

(1) Input Range and Alarm
Press MENU (switch to the setting mode).
From the setting menu, select Meas Channel > Range, Alarm.

GROUP 1 =]
/e gapery G U1 I 1or (T o)
Heas channel > Range. Alarm

First-CH E]? Last-CH @
r Range

. 1
Hode Range Span Lower  $pan lpper
[y [15v 1.888 5. 808
Scale Lover Scale Upper Lnit
[ ¢o [s@e [l
Low-cut
off
r Alarn
Relay
Type Value On/0ff  Nunber
1 On 128.8 i
2 | Oof
3 [off 5
4 | 0off
(2) Tag

From the setting menu, select Meas Channel > Tag, Memory sample, Alarm delay.

GROUP 1 = 5
Soaibm zearar e D1 I ther (S ")

Heas channel > Tag. Hemory sample. Alarn delay
First-CH Last-CH BB2

T
’7Tas ) [Fl-82 o 2

( Hemory sample

On/0ff On

fAlarn delay
(Time 18 s

Operation complete.
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Setting the Display

Setup Example 3: Assigning Channels to Groups

In this example, we will assign channels 1 and 2 to group 1.

Group 1
GROUP 1 & ;
2005712/B1 B2:49:25 DIsP N 43nin
1nin/div =
Channel 1
Channel 2
Setup Item Description Number in the Figure
Group Assign channel 1 and 2 to group 1. 1
(1) Group
Press MENU key (switch to the setting mode) and select Group set, Trip line.
GROUP 1 =3
i pceses A U NN tor  (T) 0
Group set. Trip line
Group number 1
- Group set
On/0ff n e
Group name GROUP 1 °
CH set [N °
r Trip line
1 0ff
2 0t
3 [
4 0ff
1 2 3 4 5 6 |Next 1/6

Operation complete.
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Setting the Display

Setup Example 4: Setting the Time Scale

Set the time per division of the trend waveform to 2 minutes.

]

GROUP-1

OLP-1 [t .
2BB5/12/B1 B2:11:15 DIsP | 3fnin

500 200 1

AA

o)

21.8
°c

159.5
LH

The sampling interval (the time
corresponding to 1 dot) is4 s
when the trend interval is 2 min.
30 dots x 4 s =2 min

£ 2
50
0
L 1
30 dots/div
Setup Item Description Number in the Figure
Trend interval Set the time per division to 2 minutes. 1

The waveform is updated at every 4 s.

(1) Trend Interval

Press MENU (switch to the setting mode) and select Display > Trend/Save interval.

GROUP 1 =
R 3al mopson ed DisP NN 1hor  [O)
Display > Trend/Save interval

Trend 7 Save interval

o)}

Trend interval [/div] | onin_ |
Save interval [ 1hn
3is Inin 2nin Snin 1Bnin 15min  |Next 1/2

Operation complete.
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Setting the Data Storage

Setup Example 5: Continuously Record Measured Data and Automatically Save

In this example, we will continuously record and save the measured data of channel 1

and 2.

For the procedure to set the channel, see “Setting the Input Range and Alarm” on page 28.
For the procedure to set groups, see “Setting the Display” on page 30.

GROLP 1 P _
2005/12/0] 82:11:15 DLSP NI 30nin

2nin/div

]3]

0

¢|<— Channel 1

Li~<— Channel 2

] |HH‘gl\‘HW'ET‘HH'HH‘IHEHHH‘HH“G

Automatically save to
the CF card periodically

<>

Setup Item Description Number in the Figure
Source channels Channel 1 (TI-001) and channel 2 (FI-002) 1
Data to be recorded  Continuously record the display data from 2

the start of the measurement.

Data storage method

Automatically store every 24 hours. 3

Sampling interval

4 seconds. Set using the trend update interval. 4
Sampling interval = (trend update interval setting)/
30 dots

Data file name

Add “sample” to the file name. 5
Example: 000123 sampleYYMMDD HHMMSS0.DAD
i

Sequential number Date/Time of the first recorded data and 0 (zero)

Save Destination
Directory

DATA-101 6

(1) Data to be Recorded
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the
basic setting mode).
From the basic setting menu, select A/D, Memory.

A/D, Hemory
Scan interval ——
Scan mode
Scan interval 2s
A/D intesrate Auto
Henory —‘
’}Iata kind isplave— 2
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Setting the Data Storage

(2) Method of Storing to the CF Card (Auto Save ON/OFF)
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the
basic setting mode).
From the basic setting menu, select Environment > Security, Media save, Batch.

r Security

Key
Connuni eationh off

Save —‘
lrnuto save on e 3

r Batch
On/0ff off

0ff Login | Keylock

(3) Save the Settings
1.  Press ESC to return to the basic setting menu.
2. Select End and press DISP/ENTER.
The window appears for you to confirm the saving of the settings.
3. Select Yes and press DISP/ENTER.
The DX returns to the operation mode screen.

(4) Channels to Be Recorded
Press MENU (switch to the setting mode).
From the setting menu, select Meas Channel > Tag, Memory sample, Alarm delay.

First-CH l? Last-CH [aA2
Tag —_— 1
’71'39 FI-882 ‘

Hemory sannle —‘
’70n/0ff 0n e

Alarn delay
’7Ti|ne 18 s
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Setting the Data Storage

(5) Interval for Saving the Data to the CF Card
From the setting menu, select Display > Trend/Save interval.

GROUP 1 & .
Soitm poiss e DI N 1y (©) ]
Display > Trend/Save interval

Trend / Save interval

Trend interval [/divl | omin__! 4
Save interval lday @ 3

3B Inin 2nin Snin 1Bnin 15min  |Next 172

(6) Data File Name
From the setting menu, select Data save > File header, Data file name.

GROUP 1 & .
Soibm ponsca e DI NN chor  (S) )
Data save > File header, Data file name

File header
(Char-acters | ‘

Structure Date

Identified strings [sanple ° 5

( Data file name

Input Clear Copy

(7) Save Destination Directory (within the CF Card)
From the setting menu, select Data save > Save directory.

GROUP 1 =
St acges, e U1 I shor (D) +)
Data save > Save directory

Save directory —|
’]]ir-ectnr‘y nane DATA-1A1 6

Input Clear Cony

Operation complete.
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Setting the Data Storage

Setup Example 6: Saving Measured Data at the Specified Time
Using the settings of Setup Example 5, we will save the measured data once at hour 0

every day.

Automatically save
to the CF card

<>

All settings other than those listed below are the same as Setup Example 5.
Number in the Figure

7

DX2000
\

Setup Item Description
Save the data once at hour 0 every day.

Automatically save the measured dataat 8
the specified time.

Data storage time
Data storage method

(1) Setting the Time
Press MENU (switch to the setting mode).
From the setting menu, select Timer, Event action > Match time timer.

GROLP 1 &
S poiacis R D1 N 1 () *)
Timer, Event action > Match time timer
Timer nunber
Hatch time timer
Kind Day @ 7
Day 1 o
Hour :Hinute [[HIE
Timer action Repeat ®
1 2 3 4

(2) Specifying the Data Storage
Press MENU (switch to the setting mode).
From the setting menu, select Timer, Event action > Event action.

GROUP 1 =
e sy e D1 N 1 () o)

Timer, Event action > Event action

Logic box number

Event-fction
Event HatchT imeT i ner- [ I 8
Hatch Time Timer No. 1 C ]
Action SaveDisplay C
1 2 3 1 5 [ Next 1/7

Operation complete.
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Customizing the Operation

Setup Example 7: Assigning the Screen Image Data Storage Function to the USER key
In this example, we will set the DX so that the displayed screen image data can be saved
to the CF card by pressing the USER key. This function is called snapshot. The
extension of snapshot data files is .png.

USER key
Setup Item Description Number in the Figure
Event action Save the screen image data of the DX 1

using the USER key.

(1) Assigning an Action to the USER Key
Press MENU (switch to the setting mode) and select Timer, Event action > Event
action.

GROUP 1 = , =
2005/12/81 #2:10:20 o I (S)ER )

Timer, Event action > Event action

Logic box number

Event-fAction

Event I UserKey ° 1
| |

fAction Snapshot

1 2 3 4 5 6 Next 1/7

Operation complete.
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Customizing the Operation

Setup Example 8: Registering Frequently Used Screens to the Favorite Key
Up to eight operation mode screens that are frequently used can be registered to the
Favorite key. This enables you to monitor the operation by using only the Favorite key.
This feature is convenient when comparing data such as historical trends.

[ [ Operation mode screens registered to the Favorite key
(example when three screens are registered)

Favorite key

— I

i

'.I I. \ / JI ::-'IE.-!'. . : 2 i}
Favorite key Favorite key 1 66. 6

Favorite key

1. Display the screen to be registered.

WP 1 =
121 a2:15:56 e, DiSP NN 1day

2. Press FUNC once to display the FUNC key menu.
3. Press the Next soft key to display Favorite regist.
4. Press the Favorite regist soft key to display the registration list window.

GROUP 1 r—
opgsr12/m Be:17:38 e DISP NN 1day

Register the historical
trend to the Favorite key

IM 04L42B01-02E
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Customizing the Operation

8.
9.

Operation complete.

Press the favorite number (1 to 8) soft key.
Press the Regist soft key.

GROUP 1 =
oaosi12/0 p:in:os e OIS N 1day

Show the window for
entering the display name

Enter the screen name.

Select the digit: Left and right arrow keys

Enter characters: Character/Number input keys

Delete a character: Space soft key

Cancel the setting: Press ESC before pressing DISP/ENTER.

For the input procedure, see “Entering Values and Characters” on page 18.
Press DISP/ENTER once.

Repeat steps 1 to 8 to register up to eight screens.
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Operation

Starting the Memory Sample
1. Press START once.
Memory sample starts.

el e
@ HDE> ] — Memory sample progress

DISP: Display data

Recording data
9 EVENT: Event data
St mozaz e 01 I ST E )
Inin/div ol |
&00
EESJ
N 2
300
o
200
1o
START key E o
Operation complete.
Stopping the Memory Sample
1. Press STOP once.
S 12781 02-00:08 oise I i S) B
2pinfdiv 0
ﬂ LH ) . .
: e Display the confirmation
Hemory Cancel ——— window

\/ 0
9122 1mma 19230 1234 1o o

1o:1e 19t

2. Select Mem+Math or Memory using the left and right arrow keys.
Memory: Stops memory sample.
Mem+Math: Stops memory sample and computation (option).
On models without the computation function (option), the confirmation message
“Do you want to stop data storage?” appears. Select Yes.
3.  Press DISP/ENTER once.

< —
=E
Stop memory sampling.

Operation complete.
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Operation

Switching the Trend Display, Digital Display, and Bar Graph Display

1.  Press DISP/ENTER once to show the display selection menu.

Left arrow key

‘ Up arrow key

(Al
|
|_] - - [ nght arrow key
e — DISP/ENTER key
B ] B B

L Down arrow key

2. Press the down arrow key to select TREND, DIGITAL, or BAR.

3. Pressthe right arrow key once to display the sub menu. To close the sub
menu that you opened, press the left arrow key.

4. Press the down arrow key to select the group.

GROUP 1
2005/12/8] B2:09:18

Select DIGITAL > GROUP 1

2 DIGITAL »

5. Press DISP/ENTER once to show the operation display of the selected group.
To close the menu without switching the display, press ESC.

Group number

GROUP 1 = ,
2805/12/01 62-09:18 Dis> DN 32nin  (S) o)

1 °C

218. 6

Press the down arrow key when the trend, digital, or bar graph is displayed to switch
the display in the order trend, digital, bar graph, trend, and so on. Press the up arrow
key to switch the display in reverse order. Press the right arrow key or the left arrow
key to switch the group.

Operation complete.
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Operation

Writing the Message “START”
Registering the Word “START” in Message Number 1

1.  Press MENU (switch to the setting mode) and select Message.
Press DISP/ENTER, the down arrow key once, and the Input soft key to show
the message registration window.

Hessage

Hessage No. 1-18

Characters
s R —
¢ — Show the message

registration window

= D 00 =1 OB O B €3 D3

Space Del Bs Ins A/a/l

Select the digit: Left and right arrow keys

Enter characters:  Character/Number input keys

Delete a character: Space soft key

Cancel the setting: Press ESC before pressing DISP/ENTER.

For the input procedure, see “Entering Values and Characters” on page 18.

2. Press DISP/ENTER.

Hessage

Hessage No- 1-18

r Message

Characters
START

=D 08 —d O U1 B L3 1D

51-68 |Next 172

3. Press ESC or MENU twice to return to the operation mode screen.

Operation complete.
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Operation

Writing Message Number 1 “START”
This operation can be carried out while memory sample is in progress. The message is

displayed on the trend display. Show the trend display first.
1. Press FUNC (display the FUNC key menu), press the Message soft key, and
press the 1 - 10 soft key.

GROUP 1
2885/12/61 B2:21:817

Imin/div

Show the message
registration window

1 2 6 Next 172

1 soft key

2. Press the 1 soft key.

GROUP 1 = :
2085/12/81 82:21:44 DIsP NN 58nin

1nin/div

Shows the message
(time, message, and
message mark)
Also recorded to the
internal memory

B2:21 START N

Operation complete.
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Connecting to an Ethernet Network

Setup Example 9: Monitoring the DX on a PC Browser
In this example, we will connect the PC and the DX via hub in a one-to-one relationship

and display and monitor the DX screen on a browser on the PC.

Ethernet

DX2000

DX

Setup ltem Description Number in the Figure
IP address 192.168.1.101 1

Subnet mask 255.255.255.0

Web server function

Monitor from a Web browser on the PC
using operator page.

Access to the DX

Display the Web page and do not set
access privileges.

PC
Setup Item Description Number in the Figure
IP address 192.168.1.100 4

Subnet mask

255.255.255.0

(1) IP Address of the DX
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the

basic setting mode).

From the basic setting menu, select Communication (Ethernet) > IP address, Host

seftings.

Comnunication {(Ethernet} > IP-address, Host settings

r [P-address
DHCP

Fixed IP-address
IP-address
Subnet mask
Default gateway

Not

192.168. 1.10le I

255. 255.255.  ge
B B B B

r Host settings

Host nane

Domain nane

IM 04L42B01-02E
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Connecting to an Ethernet Network

(2) Enabling the Web Server Function on the DX

From the basic setting menu, select Communication (Ethernet) > Server.

Server

FTP

Web Use @ 2
SNTP Not
Hodbus Not

(3) Display the DX Screen on the PC

From the basic setting menu, select Communication (Ethernet) > Web page.

Page type 2
Web page —

On/0ff [T

fAccess control 0ff o 3

Command Not

Operator | Honitor

(4) Save the Settings
1.  Press ESC to return to the basic setting menu.
2. Select End and press DISP/ENTER.
The window appears for you to confirm the saving of the settings.
3.  Select Yes and press DISP/ENTER.
The DX returns to the operation mode screen.

44
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Connecting to an Ethernet Network

(5) Setting the PC
Set the IP address and subnet mask on the PC.

Irternet Pratocol (T CPAIP) Prope ed e

General |

You can get [P settings assigned automatically if your network, supports
this capability. Otherwize, vou need to ask vour network. administrator for
the appropriate P settings.

" Obtain an IP address automatically

—{* Use the follawing IP address:

IP address: 192168 . 1 100 4
Subnet mask: I 255 2685 . 285 . O
Default gateway: I . . .

! Mbtain DNE server address automatically

—* Usze the following DMS server addresses:

Freferred DMS server: I . . .

Alternate DNS server: I . . .
Advanced... |
()8 I Cancel |

(6) Checking the Connection

Send the command below from the PC and check that a correct response is returned.
Send

>ping 192.168.1.101

Response example
>Reply from 192.168.1.101: bytes=32 time<10ms TTL=255

(7) Displaying the DX Screen on the Browser
1. Start the browser on the PC.
2. Enter the following URL.
http://192.168.1.101/operator.htm
3. Check that the DX screen appears.

B DPERATOR MODE I pr 01 05 - W ko intewret E e
P [d Ven Faeies Todk Hep

Qo - D - =] (2] G| o o s @] (2 L [3

alol x|

5

s [ ] bt 10,0702 P4joparsor. i

= B | i

Seiect Group =3 =
Sevect Group =» =

[Soiect Scrmen =2 =]

| S iocd et

Operation complete.
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Connecting to an Ethernet Network

Setup Example 10: Automatically Transferring the Measured Data File to an FTP Server
In this example, we will configure the DX so that the measured data is automatically
transferred to an FTP server on the network when the measured data is automatically
saved to the CF card. To automatically transfer the measured data files and report files,
the auto saving of the measured data must be configured in advance (see “Data storage
method” of the setup example 5).
This example assumes that the following network environment is used: DHCP enabled,
automatically obtain the DNS server information, and automatically register the DX host
name to the DNS server. Set the parameters according to your network environment.

Ethernet

Automatic data transfer to an FTP server
\

DX I 1 LFTP server
Internal
memory @ CF card

[
. Dmrr—rrﬁ
Measurement input @

Setup Item Description Number in the Figure
Host name DAQSTATIONA1 1
Obtain the IP address Obtain automatically (DHCP) 2
Type of data to be transferred  Acquired measured data 3
FTP server Server name abcdefg.co.jp 4

Port number 21
Login name FTPUSER1
Password al1234

(1) Host Settings and IP Address of the DX
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the
basic setting mode).
From the basic setting menu, select Communication (Ethernet) > IP address, Host
settings.

Basic Setting Hode ]
Communication (Ethernet} > IP-address, Host settings

r IP-address

DHCP 2

DNS accession Use o Automatically obtain the

Host-niane register Use o DNS server ixformation.
Automatically register the
DX host name to the DNS
server.

— Host settings
Host nane |PAASTATTONT ———1
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Connecting to an Ethernet Network

(2) Data to Be Transferred to the FTP Server and the FTP Server
From the basic setting menu, select Communication (Ethernet) > FTP client.

Communication (Ethernet) > FTP client

r FTP transfer file
DispiEvent data | on_ | 3
Report 0ff
Snapshot 0ff
r FIP connection
Primary
FTP seruer name  [abedefg °® 4
Port number 2le
Legin nane FTPUSERL C
Passuord al234 [
Aecount
PASY mode 0ff
Initial path
On 0ff

(3) Save the Settings
1.  Press ESC to return to the basic setting menu.
2. Select End and press DISP/ENTER.

The window appears for you to confirm the saving of the settings.
3. Select Yes and press DISP/ENTER.
The DX returns to the operation mode screen.

Operation complete.

Executing a File Transfer Test

1. Press FUNC once to display the FUNC key menu.
2. Press the FTP test soft key once.

GROLP 1 &3 :
2085/12/81 15:47:28 DISP NI 31nin

imin/div

‘HII|HH’E'l”HH‘HH|HLi\|III\‘HH|IIH‘§H|HH|HH|\ 5

3. Press the Primary soft key once. The messages “FTP test is being executed”

and “Execution is complete” are displayed. The test file (FTP_TEST.TXT) is
sent to the FTP server.

Operation complete.

Transferring the Data Files

When you start memory sample, the measured data file is transferred to the FTP server
when the data is saved to the CF card.
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Using DAQSTANDARD

Displaying the Measured Data on DAQSTANDARD

In this example, we will display the measured data using the accompanying software

program, DAQSTANDARD.

1. Insert the CF card containing the measured data file (.DAD or .DAE extension)

into the PC that has DAQSTANDARD installed.
2. Start DAQSTANDARD. The launcher is displayed.

AN DARD S ] [P

Launcher Help

CONFIG NETIIORE

L———————————— Data viewer icon

3. Click the data viewer icon to start the data viewer.

&, Data Viewsr —lolx|
File Wiew Help
EEIE I EE T N e e ER

146 mp 14e B[ 149 AV (42 Y

Ready |

4.  From the File menu, choose Open.
5. Inthe Open dialog box, select the desired file, and click Open.
The data is displayed.

@, Dal ver - [Display File-Graph[051006_1510000.0AD]] Y ]
File Edit Timedxis Y-Axis Wiew Window Conwert  Information Help =1l

(S E|B @@ a|u kI e[

ZEEOES O e 8 7

|140 Ap/ |46 BH) | KA AR e B)Y
GROUP 1

300+

CHOOT [C]

/NS \S

T T T T
18:52:00 18:56:00 A7.00:00 A7.04:00

P e {2459
2004 éz ;E ﬁ
1004 % %

20054 0/06 Abzolute Time [hm:s]
144
Ready ,_ g

Operation complete.
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Installation and Wiring

Installation Location

Install the DX indoors in a location that meets the following conditions.

* Instrumentation Panel
The DX is designed to be installed in an instrumentation panel except for the desktop
type.

+ Well-Ventilated Location
To prevent overheating, install the DX in a well-ventilated location. For the panel cut
dimensions when arranging multiple DXs, see the page 54. Follow the panel cut
dimensions providing adequate space between instruments when other instruments
are arranged on the panel. For the desktop type, we recommend that a space of at
least 50 mm be provided around the left, right, and top panels of the DX.

+  Minimum Mechanical Vibrations
Choose an installation location with the minimum mechanical vibration. Installing the
DX in a location with large mechanical vibration not only causes adverse effects on
the mechanism but also may hinder normal recording.

* Horizontal
Install the DX horizontally (However, the DX can be inclined up to 30 degrees
backwards for panel mounting).

Note

Condensation may occur if the DX is moved to another place where the ambient temperature

is higher, or if the temperature changes rapidly. In addition, measurement errors will result
when using thermocouples. If this happens, let the DX adjust to the new environment for at
least one hour before using it.

Do not install the DX in the following places.

+ Outdoors

+ In Direct Sunlight or Near Heat Sources
Install the DX in a place with small temperature fluctuations near room temperature
(23°C). Placing the DX in direct sunlight or near heat appliances can cause adverse
effects on the internal circuitry.

+ Where an Excessive Amount of Soot, Steam, Moisture, Dust, or Corrosive
Gases Are Present
Soot, steam, moisture, dust, and corrosive gases will adversely affect the DX. Avoid
such locations.

+ Near Strong Magnetic Field Sources
Do not bring magnets or instruments that produce electromagnetic fields close to the
DX. Operating the DX in strong magnetic fields can cause errors in the
measurements.

+ Where the Viewing of the Display Is Poor
The DX uses a TFT color LCD for the display. Therefore, viewing of the display from
an extreme angle is difficult. Install the DX so that the user can view the display from
the front.

5
@
—
=
3
=3
o
3
™
=
o
=4
=
Q
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Installation and Wiring

Installation Procedure
Installation Procedure (Panel Mount Type)

Use a steel panel of thickness 2 mm to 26 mm.
1. Insert DX from the front of the panel.
2. Mount the DX to the panel using the mounting brackets that come with the
package as shown in the figure below.

+ Use two brackets to support the top and bottom or the left and right sides of
the case (remove the seal that is covering the holes for the mounting
brackets beforehand).

+ The proper torque for tightening the mounting screws is 0.7 to 0.9 N-m.

+ Mount the DX to the rack according to the procedure below.

» First, attach the two mounting brackets and temporarily fasten the
attachment screws.

» Next, fix the DX in place by tightening the attachment screws with the
appropriate torque. When the DX is approximately perpendicular to the
panel as you fasten the screws, press the mounting bracket against the
case so that they are in contact with each other.

CAUTION

+ Tightening the screws too much can deform the case or damage the bracket.
» Be careful not to insert foreign objects or tools through the holes for the
mounting brackets in the case.

Panel Mounting Diagram

Screw temporarily|

Panel

Mounting brackets

DX case
Attachment Panel | mounting Attachment screw
screw Tr | brackets Torque driver
n e (flat blade)

In contact with
each other

(The figure shows the case when the mounting brackets
are used on the top and bottom of the case.)

Note

To achieve sulfficient dust and water proof performance, mount the DX in the middle of the panel
cut out.
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Installation and Wiring

External Dimensions and Panel Cut Dimensions
Panel Mount Type

Panel cut dimensions  \;it- mm (approx. inch)
360 min Unless otherwise specified, tolerance

(14.17) is +3% (however, tolerance is 0.3 mm
when below 10 mm).
280.2 (11.03) =
E|Q
P i
@© =
N~
281'3
(11.06)
226 (8.90) max. (When the /H2 or /PM1
% option is installed)
295.2 (11.62) 27.3 221.6 (8.72) (Dimensions before attaching
288 (11.33) (1.07 168 (6.61) the mounting bracket)
180 (7.09) 2-26 <« g
| (Allowable panel thickness) o
|
& o g A=
Q o (a=) N
N~ 0| v (=) [=1
P o N & &
@ |0 E :
|| l54.6 32.1 ol &
| 9.1 ~Na
108 | (2.15) =~ (Dimensions after attaching
(4.25) the mounting bracket)

Desktop Type (/H5[ ] Option)
282.5 (11.12)

Unit: mm (approx. inch)

Unless otherwise specified, tolerance
is +3% (however, tolerance is 0.3 mm
when below 10 mm).

5
7]

i)
=
o
=
)

=]

)
=
2
=
=
Q

253.3 (9.97) max. _—— (When the /H2 or /PM1

/ option is installed)
289.6 (11.40) 245.1 (9.65)

~
| AN | B g

= o @

AR «

e -

~| @ 5.

| N N~

]S 1 &

0 ]

U I R UJ o
e
Nig
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Installation and Wiring

Input Signal Wiring

A

» To prevent electric shock while wiring, ensure that the power supply source is
turned OFF.

CAUTION

+ If a strong tension is applied to the cable wired to the DX, the terminals of the DX
and/or the cable can be damaged. In order to prevent tension from being applied
directly on the terminals, fasten all wiring cables to the rear of the mounting panel.

+ To prevent fire, use signal wires having a temperature rating of 70°C or more.

» Do not apply a voltage exceeding the following value to the input terminals.
Otherwise, damage to the DX may result.

+ Maximum input voltage: +60 VDC
» Maximum common mode voltage: +60 VDC (under measurement category
Il conditions)
» The DX is a product of installation category II.

Precautions to Be Taken While Wiring

Take the following precautions when wring the input signal cables.

It is recommended that crimp-on lug with insulation sleeves (designed for 4-mm

screws) be used when connecting the input/output signal wires to the terminals.

However, this does not apply clamped terminals (/H2).

_)D))@ Crimp-on lug with insulation sleeves (for 4 mm screws)

For clamped terminals (/H2), the following wire is recommended.

+ Conductive cross-sectional area: 0.08 mm? to 1.5 mm? (AWG 28 to 16)

+ Length of the stripped section of the wire: Approx. 7 mm

Take measures to prevent noise from entering the measurement circuit.

+ Move the measurement circuit away from the power cable (power circuit) and ground circuit.

+ ltis desirable that the object being measured does not generate noise. However, if
this is unavoidable, isolate the measurement circuit from the object. Also, ground the
object being measured.

+ Shielded wires should be used to minimize noise caused by electrostatic induction.
Connect the shield to the ground terminal of the DX as necessary (make sure you are
not grounding at two points).

+ To minimize noise caused by electromagnetic induction, twist the measurement circuit
wires at short, equal intervals.

+ Make sure to earth ground the protective ground terminal through minimum resistance
(less than 100 Q).

When using internal reference junction compensation on the thermocouple input,

take measures to stabilize the temperature at the input terminal.

+ Always use the terminal cover.

+ Do not use thick wires which may cause large heat dissipation (cross sectional area of
0.5 mm? or less recommended).

+ Make sure that the ambient temperature remains reasonably stable. Large
temperature fluctuations can occur if a nearby fan turns ON or OFF.

Connecting the input wires in parallel with other devices can cause signal degradation,

affecting all connected devices. If you need to make a parallel connection, then

+ Turn the burnout detection function OFF.

+ Ground the instruments to the same point.

+ Do not turn ON or OFF another instrument during operation. This can have adverse
effects on the other instruments.

+ RTDs cannot be wired in parallel.
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Installation and Wiring

Wiring Procedure
A terminal cover is screwed in place on the measuring input terminal block on the rear
panel. A label indicating the terminal arrangement is affixed to the cover.
1. Turn OFF the DX and remove the terminal cover.
2. Connect the signal wires to the terminals.
3. Replace the terminal cover and fasten it with screws. The proper torque for
tightening the screws is 0.6 N-m.

Note
Input signal wires of diameter less than or equal to 0.3 mm may not be secured firmly for
clamped terminals (/H2). Fold over the conducting section of the wire, for example, to make sure
that the wire is securely connected to the clamped terminal.

Arrangement of the Input Terminals

BEE
i @
& &
o o TR el
& o?
o o TR el
Input terminal block 3 —--{o ] { + - Input terminal block 1
& 1 & :
o oY @ had
Input terminal block 4 —--{-0 ] { ﬁ- - Input terminal block 2
= &
Block Channel Assignments by Model
position| px2004 DX2008 | DX2010 | DX2020 | DX2030 | DX2040 | DX2048
1 1-4 1-4 1-10 1-10 1-10 1-10 1-12
2 5-8 11-20 11-20 11-20 13-24
3 21-30 21-30 | 25-36
4 31-40 37-48
Screw terminal Clamp terminal
CH4 CH2
CH3 CH1 CH3 CH1 b
Input terminal block 1 of b R [ HPA
the DX2004 and DX2008 %%%% ~oa ]]] ﬂzbs
DS [ |-® CH4 CH2

CH10 CH8 CH6 CH4 CH2
CH9 CH7 CH5 CH3 CH1 CH9 CH7 CH5 CH3 CH1

s e 1 JpEEE e,
DX2030, and DX2040 BRSO |+/a
’ PRRRRRRRR@ |-.

CH12 CH10 CH8 CH6 CH4 CH2
H11 CH9 CH7 CH5 CH3 CH1

Input terminal block 1 of @@@@@@@@@@@@ /o
LR DR +a Bl LB 8
Be@RRR@R@R@@|-e  cHzcHe cHE CHE CH4 CH2
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Installation and Wiring

Wiring Screw Terminals

DC voltage input/DI (ON/OFF) input TC input
Compensating leadwire
+ +
+
DC voltage input _+
(_r LI
U
RTD input DC current input
b
A +
+
€ -

B A DC current input

B — -—

Shunt resistor

fih Example: For 4 to 20 mA input, use a
shunt resistor of 250 Q + 0.1%.
Lead wire resistance per wire of

10 Q or less. Make the resistance
of the three wires equal.

Wiring Clamped Terminals
Remove the terminal block Connect the wires Connect the terminal block
Hold both ends of the terminal Hold both ends of the terminal block,
block and pull straight. align with the connector on the DX
side, and push the terminal block into
the connector.
Flat-blade

Recommended
N, length of stripped

wire: 7. mm

Ccrlelele,

Recommended wire size
0.08 to 1.5 mm? (AWG 28 to 16)

Input signal wire

First, loosen the screw at the front using a
flat-blade screwdriver. Insert the input signal
wire into the slit on the right side of the

terminal block, and fasten the screw at the front.

Note
RTD input terminals A and B are isolated on each channel. Terminal b is shorted internally
across all channels. However, terminal b is also isolated on each channel on models with the
/N1 option (Cu10, Cu25 RTD input/3 leg isolated RTD) and /N2 option (3 leg isolated RTD).
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Installation and Wiring

Optional Terminal Wiring

/N "WARNING |

+ To prevent electric shock while wiring, ensure that the power supply source is
turned OFF.

+ If a voltage of more than 30 VAC or 60 VDC is to be applied to the output
terminals, use ring-tongue crimp-on lugs with insulation sleeves on all terminals
to prevent the wires from slipping out when the screws become loose.
Furthermore, use double-insulated wires (dielectric strength of 2300 VAC or
more) for the signal wires on which a voltage of more than 30 VAC or 60 VDC is
to be applied. For all other wires, use basic insulated wires (dielectric strength
of 1390 VAC). To prevent electric shock, attach the terminal cover after wiring
and make sure not to touch the terminals.

CAUTION

+ Use the following circuit voltage for the connection to the alarm/FAIL/status

output terminal.
+ When the connection is to Mains Circuits (primary AC power source circuits):
150 V or less
» When the connection is to circuits derived from Mains Circuits (secondary
circuits): 250 V or less
(Mains Circuits voltage is less than 300 V, and connection must be used by
isolation transformer.)

» To prevent fire, use signal wires having a temperature rating of 70C or more.

+ If a strong tension is applied to the cable wired to the DX, the terminals of the
DX and/or the cable can be damaged. In order to prevent tension from being
applied directly on the terminals, fasten all wiring cables to the rear of the
mounting panel.

« Do not short the transmitter power supply output terminal or apply external
voltage to it. If you do, the DX may malfunction.

» When using the transmitter power supply output terminal, do not use current that
exceeds the maximum output current (25 mADC). If you do, the DX may
malfunction.

+ Do not short the VIDEO OUT terminal or apply external voltage to it. If you do,
the DX may malfunction.
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Note
For remote control wiring, use shielded wires to reduce noise. Connect the shield to the
functional ground terminal or the ground terminal of the DX.

Precautions to Be Taken While Wiring
It is recommended that crimp-on lug with insulation sleeves (designed for 4-mm
screws) be used when connecting wires to the optional input terminals.

_)D))@ Crimp-on lug with insulation sleeves (for 4 mm screws)

Wiring Procedure
As shown in the figure on next page, the optional terminal block is located on the rear
panel. The optional terminal block is provided on the DX when an option that requires
input/output is installed such as the alarm output relay (/A[ ] option), FAIL/status output
relay (/F1 or /F2 option), and remote control function (/R1 option), etc. A terminal cover
is screwed in place on the measuring input terminal block. A label indicating the terminal
arrangement is affixed to the cover.
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Installation and Wiring

1. Turn OFF the DX and remove the terminal cover.
2. Connect the signal wires to the terminals.

3. Replace the terminal cover and fasten it with screws. The proper torque for

tightening the screws is 0.6 N-m.

Arrangement of the Optional Terminals

eEDe

. . | . . |

I

Optional terminal block 4 —

L
q

Optional terminal block s—to
A4
&
A4

Wi &

!

&
e ok  oQ

l I

- Optional terminal block 1

- Optional terminal block 2

Terminal arrangement of /A1 to /A5, /R1, /F1,/F2, and /PM1 options (terminal block 1)

/A1 /A2
02 01 02 01
I R PR R@F D PR PR @k
D 2 PRl @@ D PR @R @
P @z @@ @ @ PR @@ @k
0 03
or 02 01 or o; 01
e @ % el @ RRek
2R @ @@ PR @ @
EmscEs @ @ @
04 03
/A3, /A4, /A5 /R1
06 05 02 01 63 C
O R PR @ B2
@ e @@ @ i x|
2 @e e @ B2En
04 03 7 852
/F1 and /F2 /PM1
Pulse input terminal
H8763C¢
ne (@ TR o Peam EREERELECLG:
C 19 e @@ @@ @@ @ e
ol ele] [elel [@Ele) 3
Sltatus output L 4 é 2 1
FAIL output Remote control input terminals

Terminal arrangement of /TPS4 and /TPS8 options (terminal block 3)

+ [ @PR@)
- [P .
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Installation and Wiring

Alarm Output Terminal, FAIL Output Terminal, and Status Output Terminal (/A1, /A2,
/A3, /A4, /A5, /F1, and /F2)

NC
Output format: Relay contact
C Contact rating: 250 VAC (50/60 Hz)/3 A, 250 VDC/0.1 A (for resistor load)
NO Withstand voltage: 1600 VAC at 50/60 Hz for one minute
(between output terminals and the ground terminal)

Remote Control Input Terminal (/R1)

- Relay contact input
(voltage-free contact)
Contact closed at 200 Q

- Transistor input (open collector) Internal circuit

ON voltage: 0.5V or less (30 mADC)
Contact open at 100 kQ or greater  Leakage current when turned OFF: Photocoupler isolation

0.25 mA or less Shared common (C)

: 5
6 3 c T @_% Allowable input voltage:
o—B8¢ o~ 5 2 7 4 1 ' 37
8 5 2

Withstand voltage: 1000 VDC for one minute between
input terminals and the ground terminal

\'
Input format:

-
1]
(=]

Pulse Input Terminal (/PM1)

« Relay contact input
(voltage-free contact)
Contact closed at 200 Q

-Transistor input (open collector)

ON voltage: 0.5V or less (30 mADC)
Leakage current when turned OFF:

Internal circuit

sV Input format:
Photocoupler isolation

Shared common (L)

Contact open at 100 kQ or greater
0.25 mA or less
7 H Allowable input voltage:

8 6 8 7 6 :
7 o @Hy By H H H . s0vbe
L L L L L L ! g7

Withstand voltage: 1000 VDC for one minute between
input terminals and the ground terminal

24 VDC Transmitter Power Supply Output Terminal (/TPS4 and /TPS8)
Connect the DX to the transmitter as shown below.

DX

Current
—_—

Transmitter power
supply output

terminal Transmitter

1

Input terminal

Shunt resistor: 250 Q

Note
To reduce noise, use a shielded cable for wiring. Connect the shield to the functional ground
terminal or the ground terminal of the DX.

Serial Interface
Connecting to the RS-232 Connector (/C2)

12345 2 RD (Received Data): Received data from the PC. Input signal to the DX.
\ | | | 3 SD (Send Data): Transmitted data to the PC. Output signal from the DX.
Ty 5 SG (Signal Ground): Signal ground.
@ 60 @ 7 RS (Request to Send): Handshaking signal when receiving data from the PC. Output signal
from the DX.
é '7 t\3 \9 8 CS (Clear to Send): I-rl]ang;haking signal when transmitting data to the PC. Input signal to
the DX.

* Pins 1, 4, 6, and 9 are not used.
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Installation and Wiring

Connecting to the RS-422A/485 (/C3)

Four-wire system Two-wire system _l
olololololo ololdldld [I FG (Frame Ground) Frame ground of the DX.
SG (Signal Ground) Signal ground.
@ @ @ @ @ @ @ @ @ SDB (Send Data B) Send data B (+).
SDA (Send Data A) Send data A (-).
- - RDB (Received Data B) Receive data B (+).
N T RDA (Received Data A) Receive data A (-).
F[ SG SDB SDA RDB RJ.A FG SG SDB SDA RDB RDA
Electric A i Electric .
potential <— Shield potential <— Shield

of the shield of the shield
Recommended length of stripped wire: 9 mm. Recommended tightening torque: 0.4-0.5 Nm

Cable
There are two types of cables available, the four-wire cable and the two-wire cable (used only for the Modbus protocol).
The cable should meet the following specifications.
* Type: Shielded twisted pair cable: 3 pairs 24 AWG or more (four-wire),
2 pair 24 AWG or more (two-wire)
« Characteristic impedance: 100 Q
» Capacitance: 50 pF/m
- Total cable length: Upto 1.2 km

Connecting to the VGA Connector (/D5)

A CAUTION

» Connect the cable after turning OFF the DX and the monitor.
» Do not short the VIDEO OUT terminal or apply external voltage to it. If you do,
the DX may malfunction.

VGA Output Terminal

VIDEO OUT(VGA) /\

00000
00000
0000
")

The DX display can be output to a monitor through the RGB output. Connectable
monitors are VGA monitors or multi-sync monitors capable of displaying VGA.

Specifications of the VGA Output Terminal

Pin No. Signal Name Specifications
1 Red 0.7 Vp-p
2 Green 0.7 Vp-p
3 Blue 0.7 Vp-

5 1 " ° p-p
5 _
6 GND

O 0O0O0O0O0 7 GND

10 © 0 6 g GND

OO0 O00O0 9 _
10 GND
11 -

15 1 12 -

D-Sub 15-pin receptacle 13 Horizontal sync signal Approx. 31.5 kHz,
TTL negative logic

14 Vertical sync signal ~ Approx. 60 Hz, TTL

negative logic
15 -
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Installation and Wiring

Connecting to the Monitor
1. Turn OFF the DX and the monitor.
2. Connect the DX and the monitor using an analog RGB cable.
3.  Turmn ONthe power to both the DX and the monitor. The DX screen is displayed
on the monitor.

Note
» When the DX is turned ON, a VGA signal is always output from the VIDEO OUT terminal.
+ The monitor screen may flicker if the DX or another instrument is brought close to the monitor.
» The edge of the screen may drop out depending on the monitor type.

Connecting to the USB Port (/USB1)
The USB port complies with Rev. 1.1.
Front Rear

l‘JSB port

USB port

Connecting to the Ethernet Port

Ethernet port
Indicator
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Checking the Connection/Communication Status
The connection status of the Ethernet interface can be confirmed with the indicator that
is located to the upper right of the Ethernet connector of the DX.

Indicator Connection Status of the Ethernet Interface

llluminated (green) The Ethernet interface is electrically connected.

Blinking (red) Transmitting data.

Off The Ethernet interface is not electrically connected.

Checking the Connection on the DX Display

+ Checking the Connection at the status indication section of the DX display.
You can check the connection status of the Ethernet interface on the Ethernet Link
indicator located on the right side of the status indication section of the basic setting
mode display. The basic setting menu appears by pressing MENU to display the
setting menu followed by FUNC for approximately 3 s.

+ Checking the Connection Status in the Display Section in the Upper Right
Corner of the Communication Log Display of the DX
You can check the connection status of the Ethernet interface on the Link indicator on
the display section in the upper right corner of the communication log display.

Indicator Connection Status of the Ethernet Interface

llluminated (green)  The Ethernet interface is electrically connected.

Off The Ethernet interface is not electrically connected.
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Installation and Wiring

Power Supply Wiring

Panel Mount Type
Precautions to Be Taken While Wiring the Power Supply
This section explains the precautions to be taken on models whose rated supply voltage is
100 to 240 VAC. Make sure to follow the warnings below when wiring the power supply.
To prevent electric shock and damage to the DX, observe the following warnings.

A

.

To prevent electric shock when wiring, ensure the main power supply is turned OFF.
To prevent the possibility of fire, use 600 V PVC insulated wire (AWG20 to 16)
or an equivalent wire for power wiring.

Make sure to earth ground the protective earth terminal through a grounding
resistance less than 100 Q before turning ON the power.

Use crimp-on lug with insulation sleeves (for 4-mm screws) for power supply
wires and protective grounding wires.

To prevent electric shock, make sure to close the transparent cover for the
power supply wires.

Make sure to provide a power switch (double-pole type) on the power supply
line in order to separate the DX from the main power supply. Put an indication
on this switch as the breaker on the power supply line for the DX and indications
of ON and OFF. Switch specifications Steady-state current rating: 1 A
or more. Inrush current rating: 60 A or more. Complies with IEC60947-1, 3.
Connect a fuse (between 2 A and 15 A) to the power line.

Do not add a switch or fuse to the ground line.

Use a power supply that meets the following conditions:

ltem Condition

Rated supply voltage 100 to 240 VAC

Allowable power supply voltage range 90 to 132/180 to 264 VAC

Rated power supply frequency 50/60 Hz

Allowable power supply frequency range 50/60 Hz + 2%

Maximum power consumption 74 VA (100 V)/100 VA (240 V)
Note

Do not use a supply voltage in the range 132 to 180 VAC, as this may have adverse effects on
the measurement accuracy.

Wiring Procedure

1.

Turn OFF the power to the DX and open the transparent power terminal cover.

2. Wirethe power cord and the protective ground cord to the power supply
terminals. Use ring-tongue crimp-on lugs (designed for 4 mm screws).

100-240V  AC~
50/60Hz 100VA MAX

b N B8

3.

Note

Do not wire the protective grounding
cord to the functional ground terminal.

Protective grounding cord

Replace the power terminal cover, and fasten it with screws.
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Installation and Wiring

Desktop Type

A

Precautions to Be Taken While Connecting the Power Supply
Make sure to follow the warnings below when connecting the power supply. To prevent
electric shock and damage to the DX, observe the following warnings.

» Before connecting the power cord, ensure that the source voltage matches the
rated supply voltage of the DX and that it is within the maximum rated voltage
range of the provided power cord.

» Connect the power cord after checking that the power switch of the DX is turned
OFF.

» To prevent electric shock or fire, be sure to use the power cord supplied by
YOKOGAWA.

» Make sure to perform protective earth grounding to prevent electric shock.
Connect the power cord of the desktop type to a three-prong power outlet with a
protective earth terminal.

» Do not use an extension cord without protective earth ground. Otherwise, the
protection function will be compromised.

. ___________________________________________________________________________________________________|

Use a power supply that meets the following conditions:

Item Condition

Rated supply voltage 100 to 240 VAC

Allowable power supply voltage range 90 to 132, 180 to 264 VAC

Rated power supply frequency 50/60 Hz

Allowable power supply frequency range 50/60 Hz = 2%

Maximum power consumption 74 VA (100V) and 100 VA (240 V)
Note

Do not use a supply voltage in the range 132 to 180 VAC, as this may have adverse effects on
the measurement accuracy.

Connection Procedure
1. Check that the power switch is OFF.
2. Connect the power cord plug to the power connector on the rear panel. (Use
the power cord that comes with the package.)

3.  Check that the power outlet meets the conditions given in the table above and
that the supply voltage is within the maximum rated voltage range of the power
cord that comes with the package. Then, connect the other end of the power
cord to the power outlet. The AC outlet must be of a three-prong type with a
protective earth ground.

IM 04L42B01-02E
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Recommended Replacement Periods for Worn

PartsMaintenance

To preserve the reliability of the DX and to use the DX in a good condition for an
extended time, it is recommended that periodic replacements be made on parts. The
following table shows the recommended replacement period for expendable parts. The
replacement period shown here applies when the recorder is used under standard
operating conditions. For the actual replacement period, consider the actual conditions
of use. Replacement of parts will be carried out by a YOKOGAWA engineer or an
engineer certified by YOKOGAWA. Contact your nearest YOKOGAWA dealer when
such replacement is necessary.

Item :i:m)adcement Name Part No. Sgggmy Notes

LCD 5 years Backlight module B9968PA 1

Battery 10 years Lithium battery B9900BR 1

Dust and water 5 years Rubber strip B8706FY 1

proof strip 5 years Key case assembly B8706BM 1 English specifications

5 years Key case assembly B8706BY 1 Japanese specifications

Aluminum electrolytic | 5 years* Power supply assembly| — 1

capacitor 5 years*® AD assembly Depends on the model

* Replacement period at the upper limit of the normal operating temperature (50°C)
The replacement period varies depending on the operating temperature and the specifications of the DX.
If the operating temperature is 30°C, it may be possible to use the parts for more than 10 years.

Note
+ The LCD replacement period indicates the half life of the brightness when the brightness is set
to the factory default setting. The half life is shortened as the brightness is set higher. The
deterioration of brightness varies depending on the condition of use, and its determination is
subjective. Consider these facts for determining the actual replacement period.
+ The color of the LCD may become yellowish as time elapses. The discoloration tends to
progress faster as the brightness is set higher.

62 IM 04L42B01-02E



Setup Iltems and Default Values

The setup items and the default values in the setting mode are listed below. Enter the
settings that you are using in the Setting column for your convenience.

Setting mode menu
GROUP 1 r= -
ongs/12/81 g2-pe-as  ped DIsP I 10min @
Page 64

Heas channel ® P Page 64 to 66
Math channel ® b Page 67 and 68"
Ext. channel ® b Page 69"
Display ® 4 Page 70

Group set, Trip line @ Page 70
fessage ® Page 70

Timer, Event action ® 4 Page 71

Data save @ b Page 72

SavesLoad @ 4 Page 72

Menu customize @ b Page 72

*: Options

Basic setting mode menu

Basic Setting Mode

Setting menu |

Page 73

/D, Hemory ® Page 73

Burnout. RJC @ Page 73

Environment @ » Page 73 and 74
Keylocke Page 74°

Logine- > Page 752

Report @ » Page 75'

Tine settines o Page 75

Load settings. Initialize® > Page 75
Comnunication (Ethernet) ® » Page 76 and 78
Comnunication (Serial) @ > Page 78'

Status relay @ Page 79

End ® Page 79

1: Options
2: Displayed when the function is enabled in the Environment settings.

s
3
go
= 3
15}
23
» 3>
= Q
X3
S3
E -2
I3
2o
2
7 3
®
>
2

sanjep }ynejoqg
pue swd)] dnjag
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Setup Items and Default Values

Date/Time > Time settings

Setup ltem Selectable Range or Selections Default Value Setting
Time set - -
Date/Time > Daylight Saving Time
Setup ltem Selectable Range or Selections Default Value Setting
Use/Not Use/Not Not
Start time > Month JAN/FEB/MAR/APR/MAY/JUN/JUL/AUG/SEP/  APR
OCT/NOV/DEC
Start time > Day order 1st/2nd/3rd/4th/Last 1st
Start time > Day of the week SUN/MON/TUE/WED/THU/FRI/SAT SUN
Start time > Hour of the day Numerical value 2
End time > Month JAN/FEB/MAR/APR/MAY/JUN/JUL/AUG/SEP/ OCT
OCT/NOV/DEC
End time > Day order 1st/2nd/3rd/4th/Last Last
End time > Day of the week SUN/MON/TUE/WED/THU/FRI/SAT SUN
End time > Hour of the day Numerical value 1
Meas channel > Range, Alarm
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number
Range > Mode Skip/Volt/TC/RTD/Scale/Delta/DI/ Volt
1-5V/Sqrt
Mode=Volt
Range 20mV/60mV/200mV/2V/6V/20V/50V 2V
Span Lower Depends on the range. -
Span Upper Depends on the range. -
Mode=TC
Range R/S/B/K/E/IT/N/W/L/U/WRe R
Span Lower Depends on the range. -
Span Upper Depends on the range. -
Mode=RTD
Range Pt/JPt Pt
Span Lower Depends on the range. -
Span Upper Depends on the range. -
Mode=Scale
Type Volt/TC/RTD/DI Volt
Range Depends on the type. -
Span Lower Depends on the range. -
Span Upper Depends on the range. -
Scale Lower —30000 to 30000, decimal position: 0 to 4 0.00
Scale Upper —30000 to 30000, decimal position: 0 to 4 200.00
Unit 6 characters or less
Mode=Delta
Type Volt/TC/RTD/DI Volt
Range Depends on the type. -
Span Lower Depends on the range. -
Span Upper Depends on the range. -
Ref.CH Meas channel number -
Mode=DI
Range Level/Cont Level
Span Lower 0,1 0
Span Upper 0,1 1
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Setup Items and Default Values

Setup Item Selectable Range or Selections Default Value Setting
Mode=1-5V
Range 1-5V 1-5V
Span Lower 0.800 to 5.200 1.000
Span Upper 0.800 to 5.200 5.000
Scale Lower —30000 to 30000, decimal position :0 to 4 0.00
Scale Upper —30000 to 30000, decimal position :0 to 4 200.00
Unit 6 characters or less -
Low-cut On/Off Off
Mode=Sqrt
Range 20mV/60mV/200mV/2V/6V/20V/50V
Span Lower Depends on the range. -
Span Upper Depends on the range. -
Scale Lower —30000 to 30000, decimal position: 0 to 4 0.00
Scale Upper —30000 to 30000, decimal position: 0 to 4 200.00
Unit 6 characters or less -
Low-cut On/Off Off
Low-cut value 0.0t0 5.0 0.5
Alarm
1,2,3,4 On/Off Off
Type H:High/L:Low/h:delta H/l:delta L/R:rate H/ H
rirate L/T:delayH/t:delayL
Value Numerical value -
Relay On/Off Off
Number 101/.../106, 111/.../116, 121/.../126, 101
131/.../136 (Depends on the model.)
S01/502/S03/.../S29/S30
Detect On/Off On

Meas channel > Tag, Memory sample, Alarm delay

Setup Item Selectable Range or Selections Default Value Setting

First-CH, Last-CH Channel number -

Tag > Tag 16 characters or less -

Memory sample > On/Off On/Off On

Alarm delay > Time 1 to 3600 10

Meas channel > Moving average

Setup Item Selectable Range or Selections Default Value Setting

First-CH, Last-CH Channel number -

Moving average > On/Off On/Off Off

Moving average > Count 210 400 2

Meas channel > Color

Setup Item Selectable Range or Selections Default Value Setting

Group of channel 001-010, etc Depends on the model.

Color Red/Green/Blue/B.violet/Brown/Orange/ Red to Gray
Y.green/Lightblue/Violet/Graly/Lime/Cyan/
Darkblue/Yellow/Lightgray/Purple/Black/Pink/
L.brown/L.green/Darkgray/Olive/DarkCyan/

S.green (24 colors)
IM 04L42B01-02E 65
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Setup Items and Default Values

Meas channel > Zone, Scale, Bar graph

Setup ltem Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number —

Zone > Lower 0to 95 0

Zone > Upper 510 100 100

Scale > Position Off/1/2/3/4/5/6/7/8/9/10 1

Scale > Division 4/5/6/7/8/9/10/11/12/C10 10

Bar graph > Base position Normal/Center Normal

Bar graph > Division 4/5/6/7/8/9/10/11/12 10

Meas channel > Partial

Setup ltem Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number -

On/Off On/Off Off

Expand 110 99% 50

Boundary Span Lower+1digit to Span Upper-1digit 0.0000

Meas channel > Alarm mark, Color scale band

Setup ltem Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number -

Alarm mark > Mark kind Alarm/Fixed Alarm

Alarm mark > Indicate on Scale On/Off Off

Alarm mark > Alarm mark color > Alarm 1 Red/Green/.../S.green (24 colors) Red

Alarm mark > Alarm mark color > Alarm 2 Same as Alarm 1 Orange

Alarm mark > Alarm mark color > Alarm 3 Same as Alarm 1 Orange

Alarm mark > Alarm mark color > Alarm 4 Same as Alarm 1 Red

Color scale band > Band area Off/In/Out Off

Color scale band > Color Red/Green/.../S.green (24 colors) Lime

Color scale band > Display position >Lower  Measuring range 0.0000

Color scale band > Display position > Upper ~ Measuring range 0.0100

Meas channel > Calibration correction

Setup ltem Selectable Range or Selections Default Value Setting

First-CH, Last-CH

Channel number

Number of set points

Off/2/3/4/5/6/7/8/9/10/11/12/13/14/15/16

Off

1 to n> MES val
1to n> True val

Value in the measuring range/measured value
Measuring range
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Setup Items and Default Values

Math channel > Calculation expression, Alarm

Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number -
Math range > Math On/Off On/Off Off
Math range > Calculation expression 120 characters or less -
Math range > Span Lower —9999999 to 99999999, decimal position: 0to 4 —
Math range > Span Upper —9999999 to 99999999, decimal position: 0to 4 —
Math range > Unit 6 characters or less -
Math alarm
1,2,3,4 On/Off Off
Type H:High/L:Low/T:delayH/t:delayL -
Value Numerical value -
Relay On/Off On/Off Off
Number 101/.../106, 111/.../116, 121/.../126, 101
131/.../136 (Depends on the model.)
S01/502/S03/.../S29/S30
Detect On/Off On
Math channel > Constant
Setup Item Selectable Range or Selections Default Value Setting
Number of constant K01 to K60 KO1
Value —9.9999E+29 to —1.0000E-30, O, 1
1.0000E-30 to —9.9999E+29
Math channel > Tag, Memory sample, Alarm delay
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number -
Tag > Tag 16 characters or less -
Memory sample > On/Off On/Off On
Alarm delay > Time 1 to 3600 10
Math channel > TLOG, Rolling average
Setup Item Selectable Range or Selections Default Value Setting
TLOG > Timer No. 1/2/3/4 1
TLOG > Sum scale Off, /s, /min, /h Off
TLOG > Reset On/Off Off
Rolling average > On/Off On/Off Off
Rolling average > Interval 1s/2s/3s/4s/5s/65/10s/12s/155/20s/30s/ 10s
1min/2min/3min/4min/5min/6min/10min/12min/
15min/20min/30min/1h
Rolling average > Number of samples 1 to 1500 1
Math channel > Color
Setup Item Selectable Range or Selections Default Value Setting
Group of channel 101-110, etc Depends on the model.
Color Red/Green/.../S.green (24 colors) Red to Gray
Math channel > Zone, Scale, Bar graph
Same as Meas channel.
IM 04L42B01-02E 67

o
®
o
)
c
—
<
D
c
o©
»

pue swa)| dnjag




Setup Items and Default Values

Math channel > Partial

Setup ltem Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number —

On/Off On/Off Off

Expand 110 99% 50

Boundary Span Lower+1digit to Span Upper—1digit 0.00

Math channel > Alarm mark, Color scale band

Setup ltem Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number —

Alarm mark > Mark kind Alarm/Fixed Alarm

Alarm mark > Indicate on Scale On/Off Off

Alarm mark > Alarm mark color > Alarm 1 Red/Green/.../S.green (24 colors) Red

Alarm mark > Alarm mark color > Alarm 2 Same as Alarm 1 Orange

Alarm mark > Alarm mark color > Alarm 3 Same as Alarm 1 Orange

Alarm mark > Alarm mark color > Alarm 4 Same as Alarm 1 Red

Color scale band > Band area Off/In/Out Off

Color scale band > Color Red/Green/.../S.green (24 colors) Lime

Color scale band > Display position > Lower Measuring range 0.00

Color scale band > Display position > Upper Measuring range 1.00

Math channel > Math start action

Setup ltem Selectable Range or Selections Default Value Setting

Math start action > Math start Off/Start/Rst+St

Start
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Setup Items and Default Values

Ext. channel > Range, Alarm

Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number -
Ext. range > On/Off Off Off
Ext. range > Span Lower —30000 to 30000, decimal position: 0 to 4 —200.00
Ext. range > Span Upper —30000 to 30000, decimal position: 0 to 4 200.000
Ext. range > Unit 6 characters or less -
Ext. alarm
1,2,3,4 On/Off Off
Type H:High/L:Low/T:delayH/t:delayL -
Value Numerical value -
Relay On/Off On/Off Off
Number 101/.../106, 111/.../116, 121/.../126, 101

131/.../136 (Depends on the model.)
S01/S02/S03/.../529/S30
Detect On/Off On

Ext. channel > Tag, Memory sample, Alarm delay

Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number -

Tag > Tag 16 characters or less -

Memory sample > On/Off On/Off On

Alarm delay > Time 1 to 3600 10

Ext. channel > Color

Setup Item Selectable Range or Selections Default Value Setting
Group of channel 201-210/211-220/221-230/.../421-430/ 201-210

431-440
Color Red/Green/.../S.green (24 colors) Red to Gray

Ext. channel > Zone, Scale, Bar graph
Same as Meas channel.

Ext. channel > Partial, Alarm mark, Color scale band
Same as Math channel.
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Setup Items and Default Values

Display > Trend (Circular)/Save interval

Setup ltem Selectable Range or Selections Default Value Setting
Trend/Save interval
Trend interval [/div] 15s/30s/1min/2min/5min/10min/15min/20min/ 1min
30min/1h/2h/4h/10h
Save interval 10min to 31day (Depends on the trend interval.) 1h
Second interval [/div] 15s/30s/1min/2min/5min/10min/15min/20min/ 1min
30min/1h/2h/4h/10h
Circular/Save interval
Time per revolution [/rev] 20min/30min/1h/2h/6h/8h/12h/16h/1day/ 1day
2day/1week/2week/4week
Save interval 10min to 31day (Depends on the time per revolution.) 1h
Offset time Off/1h to 23h (Depends on the time per revolution.)  Off
Display > Trend (Circular), Bar graph, LCD, Monitor
Setup ltem Selectable Range or Selections Default Value Setting
Trend
Trend > Direction Horizontal/Vertical/Wide/Split Horizontal
Trend > Trend clear On/Off Off
Trend > Message direction Horizontal/Vertical Horizontal
Trend > Scale > Digit Normal/Fine Normal
Trend > Scale > Value indicator Mark/Bargraph Mark
Trend > Trend line 1/2/3 2
Trend > Grid Auto/4/5/6/7/8/9/10/11/12 Auto
Circular
Circular > Full circle action Allclear/Divclear Allclear
Circular > Trend line 1/2/3 2
Circular > Grid Auto/4/5/6/7/8/9/10/11/12 Auto
Bar graph > Direction Horizontal/Vertical Vertical
LCD > Brightness 1/2/3/4/5/6 2
LCD > Backlight saver > Mode Off/Dimmer/Timeoff Off
LCD > Backlight saver > Saver time 1min/2min/5min/10min/30min/1h 1h
LCD > Backlight saver > Restore Key, Key+Alarm Key+Alarm
Monitor > Background > Display White/Black White
Monitor > Background > Historical trend White/Cream/Black/Lightgray Black
Monitor > Scroll time 5s/10s/20s/30s/1min 10s
Monitor > Jump default display Off/1min/2min/5min/10min/20min/30min/1h Off
Group set, Trip line
Setup ltem Selectable Range or Selections Default Value Setting
Group number 1/2/3/...135/36 1
Group set > On/Off On/Off Depends on the model.
Group set > Group name GROUP1 to GROUP36/16 characters or less GROUP1 etc.
Group set > CH set 39 characters or less Depends on the model.
Trip line > 1 On/Off Off
Trip line > 2 On/Off Off
Trip line >3 On/Off Off
Trip line > 4 On/Off Off
Trip line > Position 0to 100 50
Trip line > Color Red/Green/.../S.green (24 colors) 1:Red, 2:Green
3:Blue, 4:Yellow
Trip line > Line width 1/2/3 2
Message
Setup ltem Selectable Range or Selections Default Value Setting
Message No. 1-10/11-20/21-30/31-40/41-50/51-60/ 1-10

61-70/71-80/81-90/91-100

Message 1 to 100

32 characters or less
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Setup Items and Default Values

Timer, Event action > Timer

Setup Item Selectable Range or Selections Default Value Setting
Timer No. 1/2/3/4 1
Mode Off/Relative/Absolute Off
Relative > Interval 00:01 to 24:00 01:00
Relative > Reset at Math Start On/Off On
Absolute > Interval 1min/2min/3min/4min/5min/6min/10min/ 1h
12min/15min/20min/30min/1h/2h/3h/4h/
6h/8h/12h/24h
Absolute > Ref.time 0to 23 0:00
Timer, Event action > Match time timer
Setup Item Selectable Range or Selections Default Value Setting
Timer number 1/2/3/4 1
Kind Off/Day/Week/Month Off
Day 1to0 28 1
Day of the week SUN/MON/TUE/WED/THU/FRI/SAT SUN
Hour 00:00 to 23:59 00:00
Timer action Single/Repeat Repeat
Timer, Event action > Event action
Setup Item Selectable Range or Selections Default Value Setting
Logic box number 1/2/3/.../139/40 1
Event None/Remote/Relay/Switch/Timer/ None
Matchtime/Alarm/UserKey
Remote > Remote number 1/2/3/4/5/6/7/8 1
Relay > Relay number 101/.../106, 111/.../116, 121/.../126, 101
131/.../136 (Depends on the model.)
Switch > Switch No. S01/502/S03/.../S29/S30 So1
Timer > Timer No. 1/2/3/4 1
MatchTimeTimer > Match Time Timer No. 1/2/3/4 1
Action Memory/Start/Stop/Trigger/AlarmACK/ Group
Math/MathStart/MathStop/Math rst/SaveDisp/
SaveEvent/Message/Snapshot/Rate1/
2/M.sample/TimerRst/Group/Flag/
PnlLoad/Time adj
Message > Message No. 1to 100 1
Message > Write to All/Select All
Message > Group number 1/2/3/...135/36 1
Group > Group number 1/2/3/.../135/36 1
Flag > Flag number 1/2/3/4/5/6/7/8 1
TimerRst > Timer No. 1/2/3/4 1
PniLoad> Setting file number 1/2/3 1
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Setup Items and Default Values

Data save > File header, Data file name

Setup ltem Selectable Range or Selections Default Value Setting
File header > Characters 50 characters or less -
Data file name > Structure Date/Serial/Batch Date
Data file name > Identified strings 16 characters or less -
Data save > Save directory
Setup ltem Selectable Range or Selections Default Value Setting
Directory name 32 characters or less DATAO
Data save > Event data
Setup ltem Selectable Range or Selections Default Value Setting
Sample rate 25ms/125ms/250ms/500ms/1s/2s/5s/10s/ 1s
30s/60s/120s/300s/600s (Depends on the model.)
Mode Free/Single/Repeat Free
Data length 10min to 31day (Depends on the sample rate.) 1h
Pre-trigger 0/5/25/50/75/95/100 0
Trigger signal > Key On/Off On
Trigger signal > Event-Action On/Off Off
Data save > Manual sample
Setup ltem Selectable Range or Selections Default Value Setting
Manual sample number 001 to 120 001
On/Off On/Off On
Channel Channel number 001
Data save > Batch text
Setup ltem Selectable Range or Selections Default Value Setting
Text field number 1/2/3/4/5/6/7/8 1
Text field > Title of field 20 characters or less -
Text field > Characters 30 characters or less -
Save/Load
Setup ltem Selectable Range or Selections Default Value Setting
Load display data > Kind CF/USB CF
Load event data > Kind CF/USB CF
Load settings > Kind CF/USB CF
Save settings > Kind CF/USB CF
Save settings > File name 32 characters or less -
File list/delete > Kind CF/USB CF
Format > Kind CF/USB CF
Format > Volume name 11 characters or less -
Menu customize
Setup ltem Selectable Range or Selections Default Value Setting

Function menu

Select/Hide/View/Transfer

Display menu

Separate/Select/Hide/View/Transfer
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Setup Items and Default Values

Alarm
Setup Item Selectable Range or Selections Default Value Setting
Basic setting
Reflash On/Off Off
Rate of change > Decrease 1to 32 1
Rate of change > Increase 110 32 1
Indicator Hold/Nonhold Nonhold
Hysteresis
Meas CH > High/Low 0.0to 5.0 0.5
Meas CH > Delta High/Low 0.0t0 5.0 0.0
Math CH > High/Low 0.0t0 5.0 0.0
Ext. CH > High/Low 0.0t0 5.0 0.0
Switch, Relay
Internal Switch > AND None/S01/S01-S02/.../S01-S29/S01-S30 None
Relay > AND None/I01/101-102/.../101-135/101-136 None
Relay > Action Energize/De_energ Energize
Relay > Hold Hold/Nonehold Nonhold
A/D, Memory
Setup Item Selectable Range or Selections Default Value Setting
Scan interval > Scan mode Normal/Fast Normal
Normal > Scan interval 125ms/250ms(DX2004, DX2008) 125ms
1s/2s/5s(DX2010, DX2020, DX2030, DX2040, 1s
DX2048)
Normal > A/D integrate Auto/50Hz/60Hz/100ms Auto
Fast > Scan interval 25ms (DX2004, DX2008) 25ms
125ms (DX2010, DX2020, DX2030, DX2040, 125ms
DX2048)
Fast > A/D integrate 600Hz 600Hz
Memory > Data kind Display/E+D/Event Display
Burnout, RJC
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number -
Burnout set > Mode Off/Up/Down Off
RJC > Mode Internal/External Internal
RJC > Volt —20000 to 20000uV 0
Environment > Operating environment
Setup Item Selectable Range or Selections Default Value Setting
Tag/Channel Tag/Channel Tag
Language English/Japanese/Chinese English
Remote Controller ID Off/0/1/.../30/31 Off
Temperature C/IF C
Environment > View, Message, Input, Alarm
Setup Item Selectable Range or Selections Default Value Setting
View > Trend type T-Y/Circular T-Y
View > Partial On/Off Off
View > Trend rate switching On/Off Off
Message > Write group Common/Separate Common
Message > Power-fail message On/Off Off
Message > Change message On/Off Off
Input > Value on over-range Free/Over Over
Alarm > No logging On/Off Off
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Setup Items and Default Values

Environment > Security, Media save, Batch

Setup ltem Selectable Range or Selections Default Value Setting
Security > Key Off/Login/Keylock Off

Security > Communication Off/Login Off

Save > Auto save On/Off On

Batch > On/Off On/Off Off

Batch > Lot-No. digit Off/4/6/8 6

Batch > Auto increment On/Off On

Environment > Service port

Setup ltem Selectable Range or Selections Default Value Setting
FTP 0 to 65535 21

HTTP 0 to 65535 80

SNTP 0 to 65535 123

Modbus 0 to 65535 502

Environment > Math, Report

Setup ltem Selectable Range or Selections Default Value Setting
Math > Value on Error +Over/-Over +Over

Math > Value on Overflow > SUM, AVE Error/Skip/Limit Skip

Math > Value on Overflow > MAX, MIN, P-P  Over/Skip Over

Report > Report select > 1 Max/Min/Ave/Sum/Inst Ave

Report > Report select > 2 Off/Max/Min/Ave/Sum/Inst Max

Report > Report select > 3 Off/Max/Min/Ave/Sum/Inst Min

Report > Report select > 4 Off/Max/Min/Ave/Sum/Inst Sum

Report > File type Separate/Combine Separate

Keylock

Setup ltem Selectable Range or Selections Default Value Setting
Password 8 characters or less -

Key action > START Free/Lock Free

Key action > STOP Free/Lock Free

Key action > MENU Free/Lock Free

Key action > USER Free/Lock Free

Key action > DISP/ENTER Free/Lock Free

Key action > FAVORITE Free/Lock Free

Media/USB > External media Free/Lock Free

Action of Function > AlarmACK Free/Lock Free

Action of Function > Message/Batch Free/Lock Free

Action of Function > Math Free/Lock Free

Action of Function > Data save Free/Lock Free

Action of Function > E-mail/FTP Free/Lock Free

Action of Function > Time set Free/Lock Free

Action of Function > Display Function Free/Lock Free
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Setup Items and Default Values

Login
Setup Item Selectable Range or Selections Default Value Setting
User basic settings > Auto logout Off/1min/2min/5min/10min Off
User basic settings > Operation without Login  Off/Display Off
Admin settings > Admin number 1/2/3/4/5 1
Admin settings > Mode Off/Key/Comm/Web/Key+Comm Off
Admin settings > User name 20 characters or less Admin1
Admin settings > Password 8 characters or less ?2?2?7°?77?
User settings > User number 1/2/3/.../129/30 1
User settings > Mode Off/Key/Comm/Web/Key+Comm Off
User settings > User name 20 characters or less User1
User settings > Password 8 characters or less 2?7??77°77?
User settings > Authority of user Off/1/2/3/4/5/6/7/8/9/10 Off
Authority of user
Authority of user 1/2/3/4/5/6/7/8/9/10 1
Key action > START Free/Lock Free
Key action > STOP Free/Lock Free
Key action > MENU Free/Lock Free
Key action > USER Free/Lock Free
Key action > DISP/ENTER Free/Lock Free
Key action > FAVORITE Free/Lock Free
Media/USB > External media Free/Lock Free
Action of Function > AlarmACK Free/Lock Free
Action of Function > Message/Batch ~ Free/Lock Free
Action of Function > Math Free/Lock Free
Action of Function > Data save Free/Lock Free
Action of Function > E-mail/FTP Free/Lock Free
Action of Function > Time set Free/Lock Free
Action of Function > Display Function Free/Lock Free
Report
Setup Item Selectable Range or Selections Default Value Setting
Basic settings > Report kind Off/Hour/Day/Hour+Day/Day+Week/Day+Month Off
Basic settings > Date 1to 28 1
Basic settings > Day of the week (Day+week) SUN/MON/TUE/WED/THU/FRI/SAT SUN
Basic settings > Time (hour) 0to 23 0:00
Report settings > Report channel number R01/R02/R03/.../R59/R60 RO1
Report settings > On/Off On/Off On
Report settings > Channel Channel number 1
Report settings > Sum scale Off, /s, /min, /h, /day /s
Time settings
Setup Item Selectable Range or Selections Default Value Setting
Time settings > Time zone (HHMM) —1300 to 1300 900
Time settings > Time deviation limit Off/10s/20s/30s/1min/2min/3min/4min/5min 30s
Time settings > Date format Y/M/D, M/D/Y, D/IM/Y, D.M.Y Y/M/D
Load settings, Initialize
Setup Item Selectable Range or Selections Default Value Setting
Load settings > Kind CF/USB CF
Initialize > Kind Clear 1/Clear 2/Clear 3 Clear 3
Media eject CF/USB -
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Setup Items and Default Values

Communication (Ethernet) > IP-address

Setup ltem Selectable Range or Selections Default Value Setting
DHCP Use/Not Not
DNS accession Use/Not Use
Host-name register Use/Not Use
Fixed IP-address > IP-address 0.0.0.0 to 255.255.255.255 0.0.0.0
Fixed IP-address > Subnet mask 0.0.0.0 to 255.255.255.255 0.0.0.0
Fixed IP-address > Default gateway 0.0.0.0 to 255.255.255.255 0.0.0.0
Communication (Ethernet) > Host settings
Setup Item Selectable Range or Selections Default Value Setting
Host name 64 characters or less -
Domain name 64 characters or less -
Communication (Ethernet) > DNS settings
Setup ltem Selectable Range or Selections Default Value Setting
Server search order > Primary 0.0.0.0 to 255.255.255.255 0.0.0.0
Server search order > Secondary 0.0.0.0 to 255.255.255.255 0.0.0.0
Domain suffix search order > Primary 64 characters or less -
Domain suffix search order > Secondary 64 characters or less -
Communication (Ethernet) > Keep alive, Application time out
Setup ltem Selectable Range or Selections Default Value Setting
Keep alive On/Off On
Application time out > On/Off On/Off Off
Application time out > Time 1 to 120 (min) 1
Communication(Ethernet) > Server
Setup ltem Selectable Range or Selections Default Value Setting
FTP Use/Not Not
Web Use/Not Not
SNTP Use/Not Not
Modbus Use/Not Not
Communication (Ethernet) > Web page
Setup ltem Selectable Range or Selections Default Value Setting
Page type Operator/Monitor Operator
Page type=Operator
Web page > On/Off On/Off Off
Web page > Access control Off/Admin Off
Web page > Command Use/Not Not
Page type=Monitor
Web page > On/Off On/Off Off
Web page > Access control Off/Admin/User Off
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Setup Items and Default Values

Communication (Ethernet) > E-Mail

Setup Item Selectable Range or Selections Default Value Setting
Basic settings
SMTP server name 64 characters or less -
Port number 0 to 65535 25
Recipient 1 150 characters or less -
Recipient 2 150 characters or less -
Sender 64 characters or less -
Alarm settings
E-Mail Recipients > Recipient 1 On/Off Off
E-Mail Recipients > Recipient 2 On/Off Off
Active Alarms > Alarm 1 On/Off Off
Active Alarms > Alarm 2 On/Off Off
Active Alarms > Alarm 3 On/Off Off
Active Alarms > Alarm 4 On/Off Off
E-Mail Contents > Include INST On/Off Off
E-Mail Contents > Include source URL ~ On/Off Off
E-Mail Contents > Subject 32 characters or less Alarm_summary
E-Mail Contents > Header 1 64 characters or less -
E-Mail Contents > Header 2 64 characters or less -
Scheduled settings
E-Mail Recipients and Transmission time On/Off Off
>Recipient 1
E-Mail Recipients and Transmission time 1h/2h/3h/4h/6h/8h/12h/24h 24h
> Interval
E-Mail Recipients and Transmission time 00:00 to 23:56 00:00
> Ref.time
E-Mail Recipients and Transmission time On/Off Off
> Recipient 2
E-Mail Recipients and Transmission time 1h/2h/3h/4h/6h/8h/12h/24h 24h
> Interval
E-Mail Recipients and Transmission time 00:00 to 23:56 00:00
> Ref.time
E-Mail Contents > Include INST On/Off Off
E-Mail Contents > Include source URL  On/Off Off
E-Mail Contents > Subject 32 characters or less Periodic_data
E-Mail Contents > Header 1 64 characters or less -
E-Mail Contents > Header 2 64 characters or less -
System settings
E-Mail Recipients > Recipient 1 On/Off Off
E-Mail Recipients > Recipient 2 On/Off Off
E-Mail Contents > Include source URL ~ On/Off Off
E-Mail Contents > Subject 32 characters or less System_warning
E-Mail Contents > Header 1 64 characters or less -
E-Mail Contents > Header 2 64 characters or less -
Report settings
E-Mail Recipients > Recipient 1 On/Off Off
E-Mail Recipients > Recipient 2 On/Off Off
E-Mail Contents > Include source URL  On/Off Off
E-Mail Contents > Subject 32 characters or less Report_data
E-Mail Contents > Header 1 64 characters or less -
E-Mail Contents > Header 2 64 characters or less -
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Setup Items and Default Values

Communication (Ethernet) > FTP client

Setup ltem Selectable Range or Selections Default Value Setting
FTP transfer file > Disp&Event data On/Off Off
FTP transfer file > Report On/Off Off
FTP transfer file > Snapshot On/Off Off
FTP connection Primary/Secondary Primary
FTP server name 64 characters or less -
Port number 0 to 65535 21
Login name 32 characters or less -
Password 32 characters or less -
Account 32 characters or less -
PASV mode On/Off Off
Initial path 64 characters or less -
SNTP client > Use/Not Use/Not Not
SNTP client > Server name 64 characters or less -
SNTP client > Port number 0 to 65535 123
SNTP client > Access interval Off/1h/8h/12h/24h 8h
SNTP client > Access reference time 00:00 to 23:56 00:00
SNTP client > Access timeout 10s/30s/90s 30s
SNTP client > Time adjust on Start action On/Off Off
Communication (Ethernet) > Modbus client
Setup ltem Selectable Range or Selections Default Value Setting
Basic settings > Read cycle 125ms/250ms/500ms/1s/2s/5s/10s 1s
Basic settings > Retry interval Off/Amin/2min/5min/10min/20min/30min/th  2min
Server number 1-8/9-16 1-8
Modbus server settings > Port 0 to 65535 502
Modbus server settings > Modbus server name 64 characters or less -
Modbus server settings > Unit Auto/Fixed Auto
Client command number 1-8/9-16 1-8
Command settings Off/R/R-M/W/W-M Off
Command settings > Client settings > First  Depends on the command type. -
Command settings > Client settings > Last ~ Depends on the command type. -
Command settings > Server settings > Server ~ 1/2/3/.../15/16 1
Command settings > Server settings > Registers Numerical value 30001
Command settings > Server settings > Type INT16/UINT16/INT32_B/INT32_L/UINT32_B/ INT16
UINT32_L/FLOAT_B/FLOAT_L
Communication (Serial)
Setup ltem Selectable Range or Selections Default Value Setting
Basic settings > Baud rate 1200/2400/4800/9600/19200/38400 9600
Basic settings > Data length 718 8
Basic settings > Parity Odd/Even/None Even
Basic settings > Handshaking Off:Off/ XON:XON/XON:RS/CS:RS Off:Off
Basic settings > Address 1to 99 1
Basic settings > Protocol Normal/Modbus/Modbus-M Normal
Modbus master > Basic settings > Read cycle =~ 125ms/250ms/500ms/1s/2s/5s/10s 1s
Modbus master > Basic settings > Timeout  125ms/250ms/500ms/1s/2s/5s/10s/1min 1s
Modbus master > Basic settings > Retrials Off/1/2/3/4/5/10/20 1
Modbus master > Basic settings > Off/5ms/10ms/15ms/45ms/100ms Off
Inter-block delay
Modbus master > Basic settings > Off/1min/2min/5min/10min/20min/30min/1h 2min
Auto recovery
Master command number 1-8/9-16 1-8
Command settings Off/R/R-M/W/W-M Off
Command settings > Master > First Depends on the command type. -
Command settings > Master > Last Depends on the command type. -
Command settings > Slave > Address 1to 247 1
Command settings > Slave > Registers Numerical value 30001
Command settings > Slave > Type INT16/UINT16/INT32_B/INT32_L/UINT32_B/ INT16

UINT32_L/FLOAT_B/FLOAT_L
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Setup Items and Default Values

Status relay

Setup Item Selectable Range or Selections Default Value Setting
Memory/Media status On/Off Off

Measurement error On/Off Off

Communication error On/Off Off

Memory stop On/Off Off

End

Setup Item Selectable Range or Selections Default Value Setting
Do you want to store and Yes/No/Cancel -

make the new settings take effect?
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